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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you 
or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of 
third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  No 
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of 
Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, 
modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”.  The 
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.   
“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 

equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-

crime systems; and safety equipment etc. 
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property 
damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas 
Electronics product before using it in a particular application.  You may not use any Renesas Electronics product for any 
application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses incurred 
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas 
Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics.  Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.  Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas 
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and 
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation 
of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by 
you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility 
of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable laws and 
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws 
and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.  You should not use 
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use 
by the military, including but not limited to the development of weapons of mass destruction.  When exporting the Renesas 
Electronics products or technology described in this document, you should comply with the applicable export control laws and 
regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise 
places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this 
document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of 
unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document 
or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Applilet is a registered trademark of NEC Electronics Corporation. 

Windows is either a registered trademark or a trademark of Microsoft Corporation in the United States and/or other 

countries. 

Pentium is a trademark of Intel Corporation. 

 

 

 

 

 

The information in this document is current as of September, 2008. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not 
all products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application.
 "Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio

and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.

"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).

"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)
(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 

majority-owned subsidiaries.
(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 

defined above).

•

•

•

•

•

•
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PREFACE 
 

 

Readers This manual is intended for users who understand the 78K0/Kx2, 78K0S/Kx1+, 

78K0R/KE3-L, and 78K0/KC2-L and want to design and develop application systems 

and programs by using them. 

 

Purpose This manual is intended to help users understand how to use Applilet EZ PL and its 

functions, which are organized in the order below. 

 

Structure This manual consists of the following chapters: 

 

 • Overview 

 • Setting up software and hardware 

 • Starting and ending 

 • Functions of Applilet EZ PL 

 • Window reference 

 • Error messages 

 

How to Read This Manual It is assumed that the readers of this manual have general knowledge of electrical 

engineering, logic circuits, and microcontrollers. 

 

To learn about the functions of Applilet EZ PL 

→ Read this manual in the order of the CONTENTS. 

 

To learn about the hardware functions of the 78K0/Kx2 

→ See the 78K0/Kx2 product user’s manual. 

 

To learn about the hardware functions of the 78K0S/Kx1+ 

→ See the 78K0S/Kx1+ product user’s manual. 

 

To learn about the hardware functions of the 78K0R/KE3-L 

→ See the 78K0R/Kx3-L User’s Manual (U19291E). 

 

To learn about the hardware functions of the 78K0/KC2-L (under development) 

→ See the 78K0/Kx2-L User’s Manual (U19111E)Note. 

 

Note The product for this manual is under development.  The manual will be issued 

after the product is released. 

 

For information about the TK-78K0R/KE3L and TK-78K0/KC2L (under development) 

→ See the user’s manuals and application notes issued by Tessera Technology Inc.
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Conventions Data significance: Higher digits on the left and lower digits on the right 

 Active low representation: xxx (overscore over pin or signal name) 

 Note: Footnote for item marked with Note in the text 

 Caution: Information requiring particular attention 

 Remark: Supplementary information 

 Numerical representation:  Binary ... xxxx or xxxxB 

  Decimal ... xxxx 

  Hexadecimal … xxxxH 

 

Related Documents The related documents indicated in this publication may include preliminary versions.  

However, preliminary versions are not marked as such. 

 

Documents Related to Devices 

Document Name Document No. 

78K0/Kx2 User’s Manual U18598E 

78K0S/KA1+ User’s Manual U16898E 

78K0S/KB1+ User’s Manual U17446E 

78K0S/KU1+ User’s Manual U18172E 

78K0S/KY1+ User’s Manual U16994E 

78K0R/Kx3-L User’s Manual U19291E 

78K0/Kx2-L User’s Manual U19111E 

 

Caution The documents above are subject to change without notice.  Be sure to use the latest version of 

each document for design and other purposes. 
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Documents Related to Development Software Tools 

•  78K0/Kx2, 78K0/KC2-L 

Document Name Document No. 

Operation U17199E 

Language U17198E 

RA78K0 Ver. 3.80 User’s ManualNote 1

Structured Assembly Language U17197E 

RA78K0 Ver. 4.01 Operating PrecautionsNote 1 ZUD-CD-07-0181-E 

Operation U17201E CC78K0 Ver. 3.70 User’s ManualNote 2

Language U17200E 

CC78K0 Ver. 4.00 Operating PrecautionsNote 2 ZUD-CD-07-0103-E 

Operation U18601E SM+ User’s Manual 

User Open Interface U18212E 

ID78K0-QB Ver. 2.94 User’s Manual Operation U18330E 

ID78K0-QB Ver. 3.00 User’s Manual Operation U18492E 

PM plus Ver. 5.20Note 3 User’s Manual U16569E 

PM+ Ver. 6.30Note 4 User’s Manual U18416E 

Notes 1. This document is installed into the PC together with the tool when installing RA78K0 Ver. 4.01.  For 

descriptions not included in “RA78K0 Ver. 4.01 Operating Precautions”, see the user’s manual of RA78K0 

Ver. 3.80. 

 2. This document is installed into the PC together with the tool when installing CC78K0 Ver. 4.00.  For 

descriptions not included in “CC78K0 Ver. 4.00 Operating Precautions”, see the user’s manual of CC78K0 

Ver. 3.70. 

 3. PM plus Ver. 5.20 is the integrated development environment included with RA78K0 Ver. 3.80. 

 4. PM+ Ver. 6.30 is the integrated development environment included with RA78K0 Ver. 4.01.  Software tool 

(assembler, C compiler, debugger, and simulator) products of different versions can be managed. 

 

Caution The documents above are subject to change without notice.  Be sure to use the latest version of 

each document for design and other purposes. 
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•  78K0S/Kx1+ 

Document Name Document No. 

RA78K0S Ver. 1.40 or Later User’s Manual Operation U16656E 

RA78K0S Ver. 1.30 or Later User’s Manual Language U14877E 

RA78K0S ST78K0S Ver. 1.00 or Later User’s Manual Structured Assembly Language U11623E 

Operation U17391E 

Language U17390E 

RA78K0S Ver. 2.00 User’s Manual 

Structured Assembly Language U17389E 

CC78K0S Ver. 1.50 or Later User’s Manual Operation U16654E 

CC78K0S Ver. 1.30 or Later User’s Manual Language U14872E 

Operation U17416E CC78K0S Ver. 2.00 User’s Manual 

Language U17415E 

Operation U18601E SM+ User’s Manual 

User Open Interface U18212E 

ID78K0S-QB Ver. 2.90 User’s Manual Operation U18247E 

ID78K0S-QB Ver. 3.00 User’s Manual Operation U18493E 

PM plus Ver. 5.20Note 1 User’s Manual U16569E 

PM+ Ver. 6.30Note 2 User’s Manual U18416E 

Notes 1. PM plus Ver. 5.20 is the integrated development environment included with RA78K0S Ver. 1.40. 

 2. PM+ Ver. 6.30 is the integrated development environment included with RA78K0 Ver. 2.00.  Software tool 

(assembler, C compiler, debugger, and simulator) products of different versions can be managed. 

 

•  78K0R/KE3-L 

Document Name Document No. 

Operation U18547E RA78K0R Ver. 1.20 User’s Manual 

Language U18546E 

Operation U18549E CC78K0R Ver. 2.00 User’s Manual 

Language U18548E 

Operation U18601E SM+ User’s Manual 

User Open Interface U18212E 

PM+ Ver. 6.30 User’s Manual U18416E 

ID78K0R-QB Ver. 3.20 User’s Manual Operation U17839E 

Caution The documents above are subject to change without notice.  Be sure to use the latest version of 

each document for design and other purposes. 
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CHAPTER 1 OVERVIEW 
 

 

1.1 Overview 
 

Applilet EZ PL is a software tool that can be used to automatically generate microcontroller software by using only 

its GUI (graphical user interface) when installed on a host. 

By using Applilet EZ PL, the basic operations of systems using a microcontroller can be learned and evaluated 

without knowledge of complex programming languages. 

 

1.2 Features 
 

 Automatic generation of object code for the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, and 78K0/KC2-L 

 Applilet EZ PL can be used to automatically generate object code (*.hex) and a source file, which can be written 

to the flash memory in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, and 78K0/KC2-L, by assigning GUI panels, 

which represent the various functions of a microcontroller, to the input, processing, or output block area. 

 Therefore, software can be generated without special knowledge of programming languages supported by the 

78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L. 

 

 Simulation 

 Applilet EZ PL can be used to easily simulate and check the operations of the target system. 

 The operation can be checked on the PC without the target system by using this simulation function. 

 

 Automatic generation of a project file for the integrated development environment 

 A *.prj project file for the integrated development environment PM+, made by NEC, or a *.eww project file for the 

integrated development environment IAR Embedded Workbench, made by IAR Systems, is automatically 

generated at the same time as the object code (*.hex). 

 By using this project file, the source file (*.c or *.h) generated by Applilet EZ PL can be easily reedited or 

recompiled in the integrated development environment of each company. [Note] 

 

[Note] Only a source file supported by the integrated development environment PM+, made by NEC, is 

generated for a low-pin-count microcontroller (78K0S/Kx1+). 

 

 Evaluation board 

 By using Applilet EZ PL with an evaluation board, created software can be easily checked. 
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1.3 Program Development Overview 
 

Applilet EZ PL can automatically generate a program by using a simple procedure. 

 

Figure 1-1.  Program Development Overview 

 STEP 1 Set up the target (device or evaluation board)  

    

 STEP 2 Assign panels on the GUI to create a circuit  

    

 STEP 3 Simulate the circuit created on the GUI  

    

 STEP 4 Perform compilation  

    

Automatically generate a source file and object code (*.hex) 

Writing data to the microcontroller [Note] 

 

[Note] With a supported evaluation board, data can be written from Applilet EZ PL and any flash memory 

programmer can be added. 
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1.4 System Components 
 

The system components required for using Applilet EZ PL are shown below. 

 

Figure 1-2.  System Components 

 
 

 

 

 

[Note] Functions equivalent to those of a flash memory programmer might be provided 
on the target board.  For details, see the operation manual for the board. 

Applilet EZ PL 

Flash memory programmer 
[Note] 

Target board mounted with 
a microcontroller 

Peripheral 
circuit/element 

Microcontroller 

Host (Windows) 

Check the operation 

Evaluation board 

 

Write data to flash memory 
via the USB cable 

 

Automatically generate 
object code (*.hex) 

 

Compilation 

 

Simulation 

 

Edit the panel assignment 
by using a mouse 

Host 

[Operation overview] 

 

1.5 Operating Environment 
 

The operating environment required for using Applilet EZ PL is described below. 

 

(1) Host 

OS:  Windows® 2000, Windows XP, or Windows Vista [Note] 

CPU:  300 MHz Intel PentiumTM processor or faster 

Memory: At least 128 MB 

 

[Note] Under evaluation 

 

[Caution 1] It is recommended that the latest service pack be installed for any OS. 

 

[Caution 2] Use a 1 GHz Pentium III processor or faster, at least 768 MB of system memory, and a 

high-speed graphics card when using the simulation function. 

 

(2) Supported devices 

• 78K0S/Kx1+ (78K0S/KB1+, 78K0S/KA1+, 78K0S/KY1+, 78K0S/KU1+) 

• 78K0/Kx2 (78K0/KB2, 78K0/KC2, 78K0/KD2, 78K0/KE2, 78K0/KF2) 

• 78K0R/KE3-L  

• 78K0/KC2-L 
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(3) Supported evaluation boards 

• A board mounted with a supported device (such as a self-built board or TB board made by NEC Electronics) 

• One of the boards below 

 [Board that supports the 78K0R/KE3-L] 

• TK-78K0R/KE3L (Tessera Technology Inc.) 

 [Board that supports the 78K0/KC2-L] 

• TK-78K0/KC2L (Tessera Technology Inc.) 

 

[Caution 1] For the latest information about evaluation boards supported by Applilet EZ PL, see the 

Applilet EZ PL website below. 

  URL: http://www.necel.com/micro/en/development/asia/OS_Middleware/Device_Driver_ 

 Configurator/applilet-ez-pl.html 

[Caution 2] When not using a supported evaluation board, a supported evaluation board or a flash 

memory programmer that supports the microcontroller must be added to Applilet EZ PL. 

  For details about how to add a programmer, see 3.1  Using a Self-Built Board or the TB 

Board. 

 

(4) Compiler, assembler, and integrated development environment 

To automatically generate software by using Applilet EZ PL, tools made by NEC Electronics or IAR Systems 

are required in addition to Applilet EZ PL. 

Install these tools according to the development environment or CPU core [Note 1] to be used. 

 

<Tools made by NEC Electronics [Note 2]> 

• For a 78K0 core 

 Compiler: CC78K0 (Ver. 3.80 or Ver. 4.00) 

 Assembler: RA78K0 (Ver. 3.70 or Ver. 4.01) [Note 3] 

• For a 78K0R core 

 Compiler:  CC78K0R (Ver. 2.10) 

 Assembler:  RA78K0R (Ver. 1.31) [Note 3] 

 

<Tools made by IAR Systems> 

• For all core products 

 Integrated development environment: IAR Embedded Workbench (EW78K(KS) v4.60) 

 Compiler:  IAR C/C++ Compiler for NEC 78K0, 78K0S, and 78K0R (4.60) 

 Assembler: IAR Assembler for NEC 78K0, 78K0S, and 78K0R (4.60) 

 Device file: Install a device file corresponding to the product to be used. 

 Example: 78K0/Kx2: DF-78K0-Kx2-EE_xxxx [Note 4] 

  78K0/Kx2-L: DF-78K0-Kx2-L-EE_xxxx [Note 4] 

  78K0R/Kx3-L: DF-78K0R-Kx3-L-EE_xxxx [Note 4] 

 

[Note 1] A C compiler and assembler do not have to be installed for the 78K0S/Kx1+, because Applilet 

EZ PL includes the components required for automatically generating software. 

  However, to develop a system in an integrated development environment by using the generated 

source file, the following tools for 78K0S products made by NEC Electronics must be installed: 

  Compiler:  CC78K0S (V.2.01 or later) 

  Assembler: RA78K0S (V.2.00 or later) 

  Device file: DF789234 

User’s Manual  U17656EJ6V0UM 16 



CHAPTER  1   OVERVIEW 

[Note 2] When using a software tool made by NEC Electronics, software can be automatically generated 

using Applilet EZ PL without installing a device file. 

  However, to develop a system in the integrated development environment PM+ by using the 

generated source file, a device file must be installed. 

  78K0/Kx2: DF780547 

  78K0/Kx2-L: DF780588 

  78K0R/KE3-L: DF781009 

 

[Note 3] This includes the integrated development environment PM+. 

 

[Note 4] “xxxx” indicates the version. 

 

[Remark] For details about how to obtain compilers, assemblers, integrated development environments, 

and device files, visit the website for your region from the link below or contact your local NEC 

Electronics sales representative. 

 http://www.necel.com/micro/en/development/index.html 
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CHAPTER 2 SETTING UP THE SOFTWARE 
 

 

2.1 Installing Applilet EZ PL 
 

Install Applilet EZ PL according to the procedure below. 

 

[Caution] When installing Applilet EZ PL V3.6 or later to a host on which an earlier version is installed, 

uninstall the earlier version first. 

 

2.1.1 Installing Applilet EZ PL 

 

(1) Copy the installation file (*.msi) from the CD.  Next, double-click this file to run the Applilet EZ PL Setup Wizard.  

(The screenshot below shows the wizard run on Windows XP.)  Click [Next] in accordance with the displayed 

instructions. 
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(2) When Applilet EZ PL is successfully installed, the dialog box below indicating that the installation is complete is 

displayed.  Click [Close] to end the installation. 
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2.1.2 Applilet EZ PL folder structure 

When Applilet EZ PL is successfully installed, the folders and files below are copied to the specified installation 

folder. 

 

Figure 2-1.  Applilet EZ PL Folder Structure 

Installation folder (C:\Program Files\Applilet EZ PL by default) 

 TARGET\ ······································ Folder for the device or evaluation board 

  78K0KB2\ 

  78K0KC2\ 

  78K0KC2-L\ 

  78K0KD2\ 

  78K0KE2\ 

  78K0KF2\              ·············· Folder for definition files corresponding to each device [Note] 

  78K0R/KE3-L\ 

  78K0SKA1+\ 

  78K0SKB1+\ 

  78K0SKU1+\ 

  78K0SKY1+\ 

  TK-78K0KC2-L\ 

  TK-78K0RKE3-L\ 

 TOOLS\······················································· Compiler tool folder 

 WORK\························································ Compilation work folder 

  ApEZPL.exe ······································ Applilet EZ PL executable file 

  ApEZPL.ini ········································ GUI configuration file 

  ApEZPL_e.ini ···································· GUI configuration file 

  U17656EJ6V0UM00.pdf···················· This manual 

  License agreement.txt ······················· License agreement text file 

  Function and macro interface.pdf ······ File describing functions and macros 

 

[Note] The folder names differ depending on the device or board in use. 
 

········ Folder for definition files corresponding to each evaluation board [Note] 
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2.1.3 Windows [Start] menu and shortcut icon 

The Windows [Start] menu includes the [Applilet EZ PL] menu items below. 

 

Figure 2-2.  Windows [Start] Menu (Windows XP) 

 
 

The shortcut icon below is added to the desktop. 

 

Figure 2-3.  Shortcut Icon 

 
 

 

2.2 Uninstalling Applilet EZ PL 
 

Uninstall Applilet EZ PL, the C compiler, and the assembler by selecting [Add or Remove Programs] (or 

[Add/Remove Programs] for Windows 2000) in the Control Panel. 
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CHAPTER 3 SETTING UP THE HARDWARE 
 

 

This chapter describes how to set up the evaluation board to use for Applilet EZ PL.  The setup includes the 

following: 

• Installing software 

• Setting up Applilet EZ PL 

• Connecting and setting up the hardware when writing to flash memory 

Perform the setup specific to your board. 

→ See 3.1 for the setup for a self-built board or the TB board made by NEC Electronics. 

→ See 3.2 for the setup for supported evaluation boards. 

 

3.1 Using a Self-Built Board or the TB Board 
 

When using a self-built board or the TB board, the setup differs depending on the write circuit to be created or the 

flash memory programmer to be connected.  As a typical example, this section describes the setup when using 

MINICUBE2, made by NEC Electronics. 

 

3.1.1 Installing software 

Download and install the MINICUBE2 device driver and flash programming GUI.  The MINICUBE2 device driver 

and flash programming GUI are included in QB-Programmer.  To download QB-Programmer, follow the link below and 

select your region. 

http://www.necel.com/micro/en/development/index.html 

For details about the installation, see the documents provided with QB-Programmer. 

 

[Caution] For actual write operations, a parameter file containing device-specific write information is 

required in addition to QB-Programmer. 

 

3.1.2 Setting up Applilet EZ PL 

To call QB-Programmer from Applilet EZ PL, QB-Programmer must first be added to the Applilet EZ PL settings. 

Add QB-Programmer as follows: 

 

(1) Open Applilet EZ PL. 

(2) Select [Settings] in the Main window and then [Target CPU], and then select the target CPU and clock. 

(3) Click [OK] to close the dialog box. 

(4) Select [Settings] in the Main window and then [FLASH memory programmer]. 

(5) Specify the full path and name of the file of the flash memory programmer to add to [Write execution file]. 

 (With QB-Programmer Ver.2.21, the file is installed to the location below by default. 

 C:\NECTools32\QBP\V2.21\bin\qbp.exe) 

(6) Enter a startup parameter as required, and then click [OK]. 

(7) Close Applilet EZ PL. 

 

3.1.3 Connecting the hardware when writing to flash memory 

Connect MINICUBE2 to the target device before writing data to flash memory.  When writing ends, disconnect 

MINICUBE2 from the target device. 
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3.2 Using a Supported Evaluation Board 
 

To use a supported evaluation board, the USB device driver must be installed.  However, a flash memory 

programmer does not have to be installed separately, because it is included in Applilet EZ PL. 

 

[Caution] If the source file generated by Applilet EZ PL has been changed and then manually recompiled or 

disassembled, a separate flash memory programmer is required.  Use a programmer such as the 

simple flash memory programmer WriteEZx. 

 

3.2.1 Installing software 

When the host and USB cable are connected to the evaluation board for the first time, the Found New Hardware 

Wizard prompts you to install the USB driver. 

Install the USB driver according to the procedure below. 
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(1) When the host recognizes the evaluation board, Windows starts the wizard below (in the case of Windows XP).  

(The wizard might start from the page shown in (2) below, depending on your host environment.) 

 Select [Yes, this time only] or [Yes, now and every time I connect a device], and then click [Next] to continue 

installing the USB driver. 

 

 
 

(2) On the next page, select [Install from a list or specific location (Advanced)], and then click [Next]. [Note] 

 

 
 

[Note] The name of the hardware displayed in the Found New Hardware Wizard differs for each product. 
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(3) On the next page, specify the CD, including the driver or folder to which the downloaded files are expanded, 

and then click [Next]. 

 When the driver program is detected in the specified folder, the required USB driver is installed. 

 

 
 

(4) After this installation, the following page that indicates that the USB driver has been installed is displayed.  

Click [Finish] to close the Found New Hardware Wizard. [Note] 

 

 
 

[Note] A different USB driver is displayed for each product. 

 

(5) For some products, the first page of the wizard might be displayed again to install the USB Serial Converter. 

 Repeat the procedure from (1) above to install the USB Serial Converter. 
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[Remark] If a problem occurs during the installation, reinstall the USB driver by repeating the procedure. 

 

[Caution] The COM port must be set up in accordance with the product. 

 In this case, see <2> Setting up the COM port in Applilet EZ PL and set up the COM port in 

Applilet EZ PL.  Also see the manual for the evaluation board in use. 

 

3.2.2 Setting up Applilet EZ PL 

The compiler must be set up after installing Applilet EZ PL.  The COM port must also be set up depending on the 

type and configuration of the target board. 

 

3.2.2.1 Setting up the compiler 

The compiler must be set up at least once after installing Applilet EZ PL.  Install the environment described in 1.5 

(4) Compiler, assembler, and integrated development environment and select the installed environment (NEC or 

IAR) according to the procedure below. 

 

(1) Start Applilet EZ PL. 

 Select the Windows [Start] menu, [Programs], [Applilet EZ PL], and then [Applilet EZ PL]. 

(2) Select the compiler: 

 To use the compiler made by NEC Electronics 

 Select the [Settings] menu, [Compiler], and then [NEC]. 

 To use the compiler made by IAR Systems 

 Select the [Settings] menu, [Compiler], and then [IAR]. 

(3) Close Applilet EZ PL. 

 

[Caution] When using the low-pin-count microcontroller 78K0S/Kx1+, setting this item is invalid. 

 

3.2.2.2 Setting up the COM port 

The COM port is not required to be set up if using a supported evaluation board or using a device by specifying its 

name (example: 78K0/KB2).  However, the COM port must be set up in the following cases: 

• If multiple supported evaluation boards are connected to one PC 

• If a “code=3” error occurs during writing 

 

[Caution] A “code=3” error also is displayed when another application is using the COM port of the 

evaluation board.  If this error occurs, make sure that no other applications are using this port. 

 

Set up the COM port according to the procedure below. 
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<1> Checking the USB driver 

 

(1) Select the Windows [Start] menu, right-click [My Computer], and then select [Properties], or select the 

Windows [Start] menu, [Settings], [Control Panel], and select [System] to open the System Properties 

dialog box. 

(2) Select the [Hardware] tab, and then click [Device Manager]. 

(3) Click the [+] displayed next to “Ports (COM & LPT)” and confirm that a new port name, which differs 

depending on the evaluation board, has been added as shown in the screenshot below. 

 To set up the port in Applilet EZ PL, specify “COMx”, which is displayed at the same location. 

 

 

Click. 

Confirm that this item has been added 

and memorize the COMx number. [Note] 

 

[Note] A different USB driver is displayed for each product. 

 

The procedure for checking the USB driver is complete. 

If no other port names exist or an exclamation mark is displayed, the USB driver might not be installed properly. 

In this case, repeat the procedure from 3.2.1  Installing software. 

Next, set up the COM port in Applilet EZ PL. 
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<2> Setting up the COM port in Applilet EZ PL 

 

(1) Start Applilet EZ PL by using one of the following methods. 

• Select the Windows [Start] menu, [Programs], [Applilet EZ PL], and then [Applilet EZ PL].  (See Figure 

2-2 Windows [Start] Menu (Windows XP).) 

• Double click the shortcut icon.  (See Figure 2-3 Shortcut Icon.) 

(2) Select the [Settings] menu in the Main window and then [Target CPU].  Next, specify the target evaluation 

board.  Set up the clock and other items, and then click [OK]. 

(3) Select the [Settings] menu in the Main window, and then [FLASH memory programmer] to open the Flash 

Memory Programmer Settings dialog box. 

 

 
 

(4) “2” is specified in the Wait field by default.  Leave the setting as is if there are no problems when writing 

data to flash memory.  If data cannot be written to flash memory or a communication error occurs, specify 

a greater value.  (However, writing will take longer.) 

 

The procedure for checking the USB driver and setting up the COM port in Applilet EZ PL is complete. 

 

3.2.3 Setting up the hardware when writing to flash memory 

When writing to flash memory, turn on the evaluation board, and then toggle the FLASH WRITER/UART switch for 

the USB port to FLASH WRITER. 

To check the operation after data has been written, toggle the switch to UART, and then press the reset button. 
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4.1 Starting Applilet EZ PL 
 

Start Applilet EZ PL by selecting the Windows [Start] menu, [Programs], [Applilet EZ PL], and then [Applilet EZ PL] 

(as shown in Figure 2-2 Windows [Start] Menu (Windows XP)), or by double-clicking the shortcut icon on the 

desktop (as shown in Figure 2-3 Shortcut Icon). 

When Applilet EZ PL starts, the following Main window opens. 

 

Figure 4-1.  Main Window Displayed When Applilet EZ PL Starts 

 
 

 

4.2 Closing Applilet EZ PL 
 

Close Applilet EZ PL by selecting the [File] menu and then [Exit]. 
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5.1 Basic Functions of Applilet EZ PL 
 

Applilet EZ PL automatically generates object code (*.hex) that can be directly written to the flash memory provided 

in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, and 78K0/KC2-L just by using the mouse on the GUI. 

In Applilet EZ PL, programming elements that are broken down to small module units are provided as panels (see 

Figure 5-1) on the GUI.  By logically combining these panels, and assuming the combination as a processing 

sequence for compilation, software used to control the I/O devices on the evaluation board is automatically generated. 

 

Figure 5-1.  Example of Panels on the GUI 

 

[Examples of panels indicating input devices] 

 
[Examples of panels indicating output devices] 

 
[Examples of panels indicating processing] 

 
 •   •   •

    
 

 

Figure 5-2.  Basic I/O Device Connections 
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[Caution] The types of connected devices and where they are connected differ depending on the 

evaluation board used. 

 For details about the connections, see each evaluation board manual. 
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5.2 Operation Procedure 
 

The operation procedure for automatically generating object code (*.hex) or writing to flash memory by using the 

basic Applilet EZ PL functions is described below. 

 

5.2.1 Selecting the target CPU 

Click the [Settings] menu and then [Target CPU...] to open the Target CPU Settings dialog box (Figure 5-3). 

Set up the target to use in this dialog box. 

See Target CPU Settings dialog box for details about the setup. 

 

Figure 5-3.  Target CPU Settings Dialog Box 
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5.2.2 Editing panels 

Panels can be edited in the Main window of Applilet EZ PL, which automatically opens when Applilet EZ PL starts. 

In the Main window, various panels that represent programming elements are provided on the left and right sides.  

These panels can be assigned to an area that is separated into three blocks, the input block, processing block, and 

output block. 

A panel can be edited by assigning it to one of the blocks, such as by dragging and dropping the panel. 

 

Figure 5-4.  GUI Used for Editing Panels 

 

 

 

 

 

Drop the panel by using the mouse 

Input block Processing block Output block 

Panels that can be assigned to the processing block Panels that can be assigned to the input block or output block

 

Each panel is assigned assuming that it processes a signal (on or off) from the input block and passes the signal to 

the output block.  (See the section describing the Main window for details about the function of each panel and how to 

edit each panel.) 

In Applilet EZ PL, by assigning panels to the input, processing, or output block, various inputs to the 78K0/Kx2, 

78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L are converted into binary information according to the type of the panel at 

the input block and then passed to the processing block.  Furthermore, object code (*.hex) that controls the various 

outputs from the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L based on the binary information from the 

processing block according to the type of the panel at the output block is automatically generated. 
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5.2.3 Checking after editing the panels 

Check the items below after the panels are assigned to the input, processing, or output block in the Main window.  

In Applilet EZ PL, if these conditions are not satisfied, an error is output when the object code (*.hex) is automatically 

generated and compilation is aborted. 

 

(1) The required properties of all assigned panels are specified.  (The  mark indicates that the properties of the 

marked panel have not been fully specified.) 

(2)  All assigned panels are wired.  (Delete all panels not to be used.) 

(3) The same ports are not assigned to multiple I/O panels in the properties.  (This can be checked in the Port 

Setting dialog box.) 

(4) The ROM size does not exceed the size of the flash ROM provided in the product.  (Watch the Status bar when 

assigning panels [Note].) 

(5) No more than 10 instances of the [Counter], [Timer], and [Delay] panels are assigned in total (only for the 

78K0S/Kx1+). 

 

[Note]  The estimated ROM size differs from the result of actual compilation. 

 

5.2.4 Simulation 

Applilet EZ PL can simulate a created program by using panels. 

 
(1) Click the [Run] menu in the Main window, and then [Start simulation], or click . 
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(2) ON or OFF, which indicates the simulation status, is displayed for panels assigned to the input and output 

blocks. 

 

  
 

(3) Clicking the displayed ON or OFF indicator of a panel in the input block, switches the status and then the 

status of the corresponding panel in the output block is changed accordingly by the operation of a panel 

assigned to the processing block. 

(4) During simulation, the statuses of the inputs and outputs are displayed in the simulation area and whether the 

time axis signal is high or low can be checked. 

 

  

Click the ON indicator. 

 

(5) Simulation can be stopped by clicking the [Run] menu in the Main window and then [Stop simulation], by 

clicking , or by clicking the right mouse button at the relevant location in the input, processing, or output 

block, and then clicking [Stop simulation]. 

 

[Caution 1] Only execute simulation after performing the check described in 5.2.3 Checking after editing 

the panels.  If simulation is executed while panels are not fully assigned, an unintended 

operation might occur. 

[Caution 2] Simulation is not executed in real-time.  The ON/OFF response time, speed of drawing the 

simulation area, and execution time vary depending on the performance and environment of 

the PC used. 

[Caution 3] During simulation, do not perform operations other than switching the ON/OFF statuses of 

input panels or stopping simulation. 

[Caution 4] Simulation indicates the statuses of the panels at the logical level (ON/OFF).  The active level 

(H/L) of input and output panels is not reflected. 
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5.2.5 Automatically generating object code 

Object code (*.hex) is automatically generated by using the following procedure. 

 

(1) Creating a panel location file 

The current panel assignment information is saved to a panel location file (*.loc) by clicking the [File] menu and 

then [Save as…] or [Save], or by clicking  on the Toolbar.  This file includes information about all types, 

locations, and properties of panels.  By reading this file, the previous panel locations can be set up in the Main 

window again. 

 

(2)  Automatically generating object code 

Compilation that automatically generates object code (*.hex) that assumes the current assignment of panels as 

the processing sequence is executed by clicking the [Run] menu and then [Build & Write], or by clicking  on 

the Toolbar. 

The object code (*.hex) is automatically generated in the same folder as the panel location file (*.loc) saved in 

step (1).  Therefore, when editing panels, object code (*.hex) cannot be generated until a panel location file 

(*.loc) is generated (by clicking the [File] menu and then [Save as…]). 

 

[Caution] During compilation, Applilet EZ PL automatically generates object code (*.hex) by saving the 

information about the current panel assignment to a temporary panel location file (*.loc) and then 

referencing that file.  Therefore, if compilation is executed without saving the information about 

the current panel assignment after editing panels, the saved panel location file (*.loc) and 

generated object code (*.hex) might not match. 

 

5.2.6 Writing to the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L (flash writing)  

If compilation was completed normally in (2)  Automatically generating object code, Applilet EZ PL displays the 

following confirmation message. 

 

 
 

If [OK] is clicked, the flash memory provided in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, and 78K0/KC2-L is 

written to.  The write processing differs depending on the target CPU. 

 

• If the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L is selected (if using a self-built board or the TB 

board) 

 The pre-registered flash memory programmer is called.  Use this flash memory programmer to write to the flash 

memory. 

 For details, see 3.1 Using a Self-Built Board or the TB Board. 
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• If the supported evaluation board is selected 

 Applilet EZ PL automatically starts writing to the flash memory. 

 

[Caution] To use the supported evaluation board when writing to the flash memory, the evaluation board 

must be turned on in advance, and the FLASH WRITER and UART switches for the USB port must 

be toggled to the side of the FLASH WRITER. 

 To test the operation after writing to the flash memory, toggle these switches to the UART side 

and then press the reset button after. 

 

Figure 5-5.  Operation up to Automatically Generating Object Code and Writing to the Flash Memory 

[GUI] 

 
 

INPUT
I_01:SW  L,P4.0       ;1
I_02:SW  L,P4.1       ;2
I_03:KEY     L,P3.0       ;1
I_04:KEY     L,P3.1       ;2
;
PROCESS 
0101:LINE   LR
0201:LINE   LR,LD
0202:LINE   UD
0203:LINE   UR
0301:TIM           T,1.000S
      :
      :
OUTPUT
O_01:LAMP  L,P2.3       ;1
O_02:LAMP  L,P13.0     ;2
O_03:LAMP  L,P2.2       ;3
       :

.............................

.............................

.............................

.............................
       :
       :
       :

 
 

78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 

78K0/KC2-L on the evaluation board 

Writing to the flash memory automatically 

starts after compilation ends normally. 

Compiled

[Object code (*.hex)] 

Saved Read 

[Panel location file (*.loc)] 

 

 

5.2.7 Generating a PM+ project file 

If compilation ends normally, a PM+ project file (*.prj) is automatically generated at the same time [Note]. 

Software generated by using Applilet EZ PL can be learned about and evaluated in more detail by loading this 

project file to PM+.  (For details, see APPENDIX A  AUTOMATICALLY GENERATED FILES (FOR 78K0/Kx2 AND 

78K0R/KE3-L).) 

 

[Note] For products using a 78K0S microcontroller, only a source file is generated, not a project file. 
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6.1 Overview of Windows and Dialog Boxes 
The following windows and dialog boxes are used in Applilet EZ PL. 

 

Table 6-1.  Windows and Dialog Boxes Used in Applilet EZ PL 

Name of Window or Dialog Box Functional Overview 

Main window This window automatically opens when Applilet EZ PL starts.  Panels are edited in this 

window. 

Property Settings dialog box This dialog box is used to specify panel properties. 

The dialog box differs depending on the panel type. 

Port Setting dialog box This dialog box displays the I/O ports specified in the properties. 

Target CPU Settings dialog box  This dialog box is used to specify the device or board and the system clock source to 

be used. 

Watchdog Timer Setting dialog box This dialog box is used to select and set up the watchdog timer. 

UART0 Settings dialog box This dialog box displays the UART0 I/O properties. 

UART1 Settings dialog box This dialog box displays the UART1 I/O properties. 

UART6 Settings dialog box This dialog box displays the UART6 I/O properties. 

Flash Memory Programmer Settings 

dialog box

This dialog box is used to set up the flash memory programmer used for writing to the 

flash memory.  

Different items are displayed depending on the device or board selected in the Target 

CPU Settings dialog box. 

• If the 78K0S/Kx1+, 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, or TK-

78K0/KC2L is selected 

 A dialog box for adding the flash memory programmer is displayed.  Enter the 

installation path and file name of any flash memory programmer.  A start option can 

also be entered. 

• If a different device is selected 

 Set up the COM ports connected to each product and waits. 

Saved Data Folder dialog box This dialog box is used to specify where to save data. 
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6.2 Description of Each Window and Dialog Box 
 

Each window and dialog box used in Applilet EZ PL is described in the following format.  (The main window is used 

as an example.) 

 

 

 

Main window 
 

This window automatically opens when Applilet EZ PL starts. 

In Applilet EZ PL, object code (*.hex) that can be directly written to the flash memory 

provided in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L is automatically 

generated by assigning the panels provided on the pallet in this window to the editing area 

based on the processing to be performed. 

 

 

 

 

 

 

 

 

A screenshot of the window 
or dialog box and function 
details are shown. 

• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
 

A function overview is 
provided and how to open 
the window or dialog box is 
described. 

Window or dialog box name 
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Main window 
 

This window automatically opens when Applilet EZ PL starts. 

In Applilet EZ PL, object code (*.hex) that can be directly written to the flash memory provided in the 78K0/Kx2, 

78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L is automatically generated by assigning the panels provided on the pallet 

in this window to the editing area based on the processing to be performed.   

 

Figure 6-1.  Main Window 

 

 

 
 

 
Pallet 

(Processing panels) 

Toolbar Menu bar Editing area I/O panel switching tabs 

Input block area Processing block area Output block area 

Build, simulation, and help areas 

Status bar Pallet (Input panels and  
Output panels) 
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[Caution] The main window differs depending on the “Target” setting in the Target CPU Settings dialog box 

that opened by clicking the [Settings] menu and then [Target CPU…]. 

 Be sure to perform the setup corresponding to the CPU to be used. 

 

The following items are described in this section: 

 Editing area

 Build, simulation, and help areas

 Panel functions

 Editing panels

 Saving and reading data

 Automatically generating object code and writing to flash memory

 Right-click menu

 Menu bar

 Toolbar

 Status bar

 

Editing area 
Panels are edited in this area. 

The editing area is divided into three areas, each for a different purpose. 

 

(1) Input block area 

Panels indicating devices that process inputs to the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L are 

assigned to this area.  It is made up of 40 blocks vertically.  Signals according to the properties of the panels 

assigned to this area are assumed to be values input to the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 

78K0/KC2-L and are passed to the processing block.  (All signals are either on or off.) 

Only Input panels can be assigned to this area. 

 

(2) Processing block area 

This area is used to edit the processing to pass signals from the panels assigned to the input block to the 

output block.  It is made up of 40 by 16 blocks.  The processing of a panel assigned to a block uses the signal 

from the adjacent block to the left and above as the input and outputs the signal to the block to the right and 

below. 

A signal according to the panel assigned to the block at the last column of this area is passed to the output 

block. 

Only Processing panels can be assigned to this area. 

 

(3) Output block area 

Panels indicating devices that process outputs from the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L 

are assigned to this area.  It is made up of 40 blocks vertically.  Various signals output from the 78K0/Kx2, 

78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L are controlled based on the signal passed from the block at the 

last column of the processing block area according to the properties of the panels assigned to this area. 

Only Output panels can be assigned to this area. 
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Build, simulation, and help areas 
These areas include build, simulation, and help areas. 

The areas are switched between by clicking the tabs on the top left. 

 

(1) Build area 

After editing the panels in the editing area and compiling them by clicking the [Run] menu and then [Build & 

Write], or by clicking , the compilation result will be displayed in this area. 

 

(2) Simulation area 

After editing the panels in the editing area and simulating them by clicking the [Run] menu and then [Start 

simulation], or by clicking , the output waveforms (H or L) of the panels being simulated will be displayed in 

this area. 

 

Figure 6-2.  Simulation Area 

 

 
 

The H or L status of each panel is 

displayed as a waveform. 
Input and output panels 

 

 

(3) Help area 

This area displays details about each panel, such as the name and function. 

The details about a panel on the pallet can be displayed by clicking the panel, right-clicking, and then selecting 

[Description]. 

The details about a panel assigned to the processing area can be displayed by clicking the panel, right-clicking, 

and then selecting [Description], or by clicking the panel, the [Help] menu, and then [Panel Description]. 
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Panel functions 
The functions of the Input panels, Output panels, and Processing panels provided on the pallet are described 

below. 

The properties of panels that are used (assigned) during editing must be specified according to their purpose.  

(Some panel properties are not specifiable, and some are not required.)  The panels marked by a  mark in the 

editing area indicates that the properties of the marked panel have not been fully specified. 

For details about how to specify the properties of each panel, see the section describing the Property Settings 

dialog box. 

 

(1) I/O panel switching tabs 

According to their purpose, input and output panels are displayed on the pallet on separate tabs.  Edit panels 

by switching between the tabs as required. 

The tab names and the panel categories are as follows. 

 

(a) [Common] tab 

Panels that indicate general-purpose I/O devices are organized on this tab. 

This tab is displayed for any product. 

 

(b) [Evaluation Board I/Os] tab 

Panels that indicate I/O devices on an evaluation board are organized on this tab (example: [TK-

78K0R/KE3L I/Os] tab). 

This tab is displayed if an evaluation board was selected in the Target CPU Settings dialog box. 

 

(c) [Other I/Os] tab 

Panels that indicate devices not provided on an evaluation board are organized on this tab. 

This tab is displayed if the 78K0/Kx2, 78K0/KC2-L, or TK-78K0/KC2L was selected in the Target CPU 

Settings dialog box. 

 

(2) Input panels 

Input panels can be assigned to the input block area and include the following. 

 

(a) [Common] tab 

The properties of the input panels on the [Common] tab that are assigned to the pallet are not specified by 

default (except the active level), so that the panels can be flexibly edited.  Therefore, the properties of all 

the panels assigned to the input block area must be specified. 

Multiple instances of each panel on the [Common] tab can be assigned to the input block area and the 

properties of each instance can be specified. 

 

User’s Manual  U17656EJ6V0UM 42 



CHAPTER  6   WINDOW  REFERENCE 

Table 6-2.  Input Panels ([Common] Tab) 

Panel Description 

Name Digital input 

Function This panel represents a digital input.  

It can be used to turn chattering protection on or off. 
 

Names of supported 

devices and boards 

All products 

Default properties - Displayed name:  None 

- Assigned ports:  None (must be specified) 

- Active:  H 

- Chattering removal:  Not checked 

 Property settings of [Digital input] panel

Name Analog input 

Function This panel represents an analog input. 

It is used to process analog inputs using the built-in A/D converter of the 78K0/Kx2, 

78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L. 

Compare type 

If the A/D converted value is at least the value specified in the properties or in the 

range of the specified values, output is enabled.  If multiple values are specified, the 

panel is stretched vertically (up to 10 stages) and the outputs corresponding to the 

specified values can be passed to the processing block. 

Bit type 

If the bits of the A/D converted value are 1, the bits are enabled and output.  The 

panel is stretched vertically (up to 8 stages) according to the specified number of 

output bits (outputting the higher n bits) and the outputs corresponding to the 

specified bits can be passed to the processing block. 

 

μPD78F92xx among 78K0S/Kx1+ products, 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, 

TK-78K0R/KE3L, TK-78K0/KC2L 

Names of supported 

devices and boards 

Default properties - Displayed name:  None 

- Assigned ports:  None (must be specified) 

- Gain of operational amplifier (78K0R/KE3-L and TK-78K0R/KE3L only): 

 This can be specified only if P80/CMP0P/INTP3/OAI is selected 

for the port to be assigned (must be specified). 

- Type:  None (must be specified) 

 Property settings of [Analog input] panel
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Panel Description 

Name UART6 input 

Function This panel is used to perform UART reception (by using the serial interface UART6). 

Compare type

If the received data matches the value specified in the properties, output is enabled.  

If multiple values are specified, the panel is stretched vertically (up to 10 stages) and 

the outputs corresponding to the specified values can be passed to the processing 

block. 

Bit type 

If the bits of the received data are 1, the bits are enabled and output.  The panel is 

stretched vertically (up to 8 stages) according to the specified number of output bits 

(outputting the higher n bits) and the outputs corresponding to the specified bits can 

be passed to the processing block. 

 

Names of supported 

devices and boards 

78K0S/KB1+, 78K0S/KA1+, 78K0/Kx2, 78K0/KC2-L, TK-78K0/KC2L 

Default properties - Displayed name:  None 

- Assigned ports:  P14/RxD6 (for 78K0/Kx2, 78K0/KC2-L, TK-78K0/KC2L) 

 P44/RxD6 (for 78K0S/KB1+ and 78K0S/KA1+) 

- Selected type:  None (must be specified) 

 Property settings of [UART6 input] panel

Name UART0 input 

Function This panel is used to perform UART reception (by using the serial interface UART0). 

Compare type 

If the received data matches the value specified in the properties, output is enabled.  

If multiple values are specified, the panel is stretched vertically (up to 10 stages) and 

the outputs corresponding to the specified values can be passed to the processing 

block. 

Bit type 

If the bits of the received data are 1, the bits are enabled and output.  The panel is 

stretched vertically (up to 8 stages) according to the specified number of output bits 

(outputting the higher n bits) and the outputs corresponding to the specified bits can 

be passed to the processing block. 

 

Names of supported 

devices and boards 

78K0Kx2, 78K0R/KE3-L, TK-78K0R/KE3L 

- Displayed name:  None Default properties 

- Assigned ports:  P11/SI10/RxD0 (for 78K0/Kx2) 

 P74/KR4/SI00/RxD0 (for 78K0R/KE3-L and TK-78K0R/KE3L) 

- Selected type:  None (must be specified) 

 Property settings of [UART0 input] panel
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Panel Description 

Name UART1 input 

Function This panel is used to perform UART reception (by using the serial interface UART1). 

Compare type 

If the received data matches the value specified in the properties, output is enabled.  

If multiple values are specified, the panel is stretched vertically (up to 10 stages) and 

the outputs corresponding to the specified values can be passed to the processing 

block. 

Bit type 

If the bits of the received data are 1, the bits are enabled and output.  The panel is 

stretched vertically (up to 8 stages) according to the specified number of output bits 

(outputting the higher n bits) and the outputs corresponding to the specified bits can 

be passed to the processing block. 

 

Names of supported 

devices and boards 

78K0R/KE3-L, TK-78K0R/KE3L 

- Displayed name:  None Default properties 

- Assigned ports:  P31/SI10/RxD1/SDSA10/INTP1 

- Selected type:  None (must be specified) 

 Property settings of [UART1 input] panel

Name LVI 

Function This panel compares the voltage and set value of VDD or EXLVI by using low-voltage 

detection (LVI). 

 

Names of supported 

devices and boards 

78K0S/Kx1+, 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L,  

TK-78K0/KC2L 

- Displayed name:  None Default properties 

- Voltage detection pin:  None (must be specified) 

- Detection level:  Can be specified if the voltage detection pin is specified 

 (must be specified) 

 Property settings of [LVI] panel
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(b) [TK-78K0R/KE3L I/Os] and [TK-78K0/KC2L I/Os] tabs 

The properties of the input panels assigned to the pallet on the [TK-78K0R/KE3L I/Os] and [TK-

78K0/KC2L I/Os] tabs, such as the assigned ports, are specified by default, so the input devices on the 

evaluation board can be used as they are. 

Therefore, only the properties of the panels assigned to the input block area, which must be added or 

corrected, can be specified.  (The properties of assigned panels marked with a  mark in the editing area 

must be specified.) 

Only one instance of each panel on these tabs can be assigned to the input block area, and panels are 

displayed in gray after being assigned. 

 

[Caution] The ports assigned to each of the panels on this tab cannot be changed.  (Other default 

properties can be changed.) 

 

Table 6-3.  Input Panels ([TK-78K0R/KE3L I/Os] and [TK-78K0/KC2L I/Os] Tabs) 

Panel Description 

Name Push button 

Function This panel represents a push button switch. 

It can be used to turn chattering protection on or off. 

 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  SW5 Default properties 

- Assigned ports:  P120/INTP0/EXLVI (for TK-78K0R/KE3L) 

 P30/INTP1 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  30 ms 

 Property settings of [Push button] panel

Name Push button 

Function This panel represents a push button switch. 

It can be used to turn chattering protection on or off. 
 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  SW6 Default properties 

- Assigned ports:  P32/SCK10/SCL10/INTP2 (for TK-78K0R/KE3L) 

 P33/TI51/TO51/INTP4 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  30 ms 

 Property settings of [Push button] panel
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Panel Description 

Name DIP switch 

Function This panel represents a DIP switch. 

It can be used to turn chattering protection on or off. 
 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  DIP SW3-4 Default properties 

- Assigned ports:  P33 (for TK-78K0R/KE3L) 

 P70/KR0 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  50 ms 

 Property settings of [DIP switch] panel

Name DIP switch 

Function This panel represents a DIP switch. 

It can be used to turn chattering protection on or off. 
 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  DIP SW3-5 Default properties 

- Assigned ports:  P42 (for TK-78K0R/KE3L) 

 P71/KR1 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  50 ms 

 Property settings of [DIP switch] panel
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Panel Description 

Name DIP switch 

Function This panel represents a DIP switch. 

It can be used to turn chattering protection on or off. 

 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  DIP SW3-6 Default properties 

- Assigned ports:  P43 (for TK-78K0R/KE3L) 

 P72/KR2 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  50 ms 

 Property settings of [DIP switch] panel

Name DIP switch 

Function This panel represents a DIP switch. 

It can be used to turn chattering protection on or off. 

 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  DIP SW3-7 Default properties 

- Assigned ports:  P77/KR7 (for TK-78K0R/KE3L) 

 P73/KR3 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  50 ms 

 Property settings of [DIP switch] panel

Name DIP switch 

Function This panel represents a DIP switch. 

It can be used to turn chattering protection on or off. 
 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  DIP SW3-8 Default properties 

- Assigned ports:  P76/KR6 (for TK-78K0R/KE3L) 

 P74/KR4 (for TK-78K0/KC2L) 

- Active: L 

- Chattering removal:  Checked 

- Removal time:  50 ms 

 Property settings of [DIP switch] panel
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Panel Description 

Name Analog input (illuminance)  

Function This panel indicates the illuminance. 

It is used to process analog inputs using the built-in A/D converter of the 

78K0R/KE3-L or 78K0/KC2-L. 

Compare type 

If the A/D converted value is at least the value specified in the properties or in the 

range of the specified values, output is enabled.  If multiple values are specified, the 

panel is stretched vertically (up to 10 stages) and the outputs corresponding to the 

specified values can be passed to the processing block. 

Bit type 

If the bits of the A/D converted value are 1, the bits are enabled and output.  The 

panel is stretched vertically (up to 8 stages) according to the specified number of 

output bits (outputting the higher n bits) and the outputs corresponding to the 

specified bits can be passed to the processing block. 

 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Displayed name:  Illuminance Default properties 

- Assigned ports:  P80/CMP0P/INTP3/OAI (for TK-78K0R/KE3L) 

 P10/ANI8/AMP1-/SCK10 (for TK-78K0/KC2L) 

- Selected type:  None (must be specified) 

 Property settings of [Analog input (illuminance)] panel

 

(3) Output panels 

Output panels can be assigned to the output block area and include the following. 

 

(a) [Common] tab 

The properties of the output panels on the [Common] tab that are assigned to the pallet are not specified 

by default (except the active level), so that the panels can be flexibly edited.  Therefore, the properties of all 

the panels assigned to the output block area must be specified. 

Multiple instances of each panel on the [Common] tab can be assigned to the output block area and the 

properties of each instance can be specified. 
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Table 6-4.  Output Panels ([Common] Tab]) 

Panel Description 

Name Digital output 

Function This panel represents a digital output. 

It is used to process the output of a port. 
 

Names of supported 

devices and boards 

All products 

Default properties - Displayed name:  None 

- Assigned ports:  None (must be specified) 

- Active: H 

 Property settings of [Digital output] panel

Name Simple PWM 

Function This panel outputs a pulse to the digital output port. 

The panel is stretched vertically (to three or five stages) by specifying the duty factor 

in the properties, and a pulse is output by inputting a 1 for each duty factor.  (The 

frequency cannot be specified). 

 

Names of supported 

devices and boards 

All products 

- Displayed name:  None Default properties 

- Assigned ports:  None (must be specified) 

- Active: H (fixed) 

- Output:  None (must be selected from the specified values) 

 Property settings of [Simple PWM] panel

Name PWM output 

Function This panel is used to perform PWM (pulse width modulation) using timer output of 

the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L. 

The panel is stretched vertically (up to 15 stages) by specifying multiple duty factors 

in the properties, and a PWM signal is output with the specified duty factor by 

inputting a 1 for each duty factor.  (If multiple 1s are input at the same time, 0s are 

output.) 

 

μPD78F92xx among 78K0S/Kx1+ products, 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, 

TK-78K0R/KE3L, TK-78K0/KC2L 

Names of supported 

devices and boards 

Property settings of [PWM output] panel. - Assigned ports: See Default properties 

- Frequency:  None (must be specified) 

- Duty factor:  None (must be specified) 

 Property settings of [PWM output] panel  
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Panel Description 

Name UART6 output 

Function This panel is used to perform UART transmission (by using the serial interface 

UART6). 

A panel that has the number of stages equivalent to the data bit length is assigned to 

the output block area by specifying the communication parameters. 

Transmission starts when the input is enabled. 

Specify the communication parameters in the UART6 Settings dialog box opened by 

clicking the [Settings] menu, [CPU Function], and then [UART6]. 

Remark To use this panel in Applilet EZ PL V3.6 or an older version, assign it with 

the [UART6 jumper output] processing panel. 

 

Names of supported 

devices and boards 

78K0S/KB1+, 78K0S/KA1+, 78K0/Kx2, 78K0/KC2-L, TK-78K0/KC2L 

Default properties - Assigned ports:  P13/TxD6 (for 78K0/Kx2, 78K0/KC2-L, and TK-78K0/KC2L) 

 P43/TxD6/INTP1 (for 78K0S/KB1+ and 78K0S/KA1+) 

 Property settings of [UART6 output] panel

Name UART0 output 

Function This panel is used to perform UART transmission (by using the serial interface 

UART0). 

A panel that has the number of stages equivalent to the data bit length is assigned to 

the output block area by specifying the communication parameters. 

Transmission starts when the input is enabled. 

Specify the communication parameters in the UART0 Settings dialog box opened by 

clicking the [Settings] menu, [CPU Function], and then [UART0]. 

Remark To use this panel in Applilet EZ PL V3.6 or an older version, assign it with 

the [UART0 jumper output] processing panel. 

 

Names of supported 

devices and boards 

78K0/Kx2, 78K0R/KE3-L, TK-78K0R/KE3L 

- Assigned ports:  P10/SCK10/TxD0 (for 78K0/Kx2) Default properties 
 P73/KR3/SO00/TxD0 (for 78K0R/KE3-L and TK-78K0R/KE3L) 

 Property settings of [UART0 output] panel

Name UART1 output 

Function This panel is used to perform UART transmission (by using the serial interface 

UART1). 

A panel that has the number of stages equivalent to the data bit length is assigned to 

the output block area by specifying the communication parameters. 

Transmission starts when the input is enabled. 

Specify the communication parameters in the UART1 Settings dialog box opened by 

clicking the [Settings] menu, [CPU Function], and then [UART1]. 

 

Names of supported 

devices and boards 

78K0R/KE3-L, TK-78K0R/KE3L 

- Assigned ports: P30/SO10/TxD1 Default properties 

 Property settings of [UART1 output] panel
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Panel Description 

Name Step motor  

Function This panel outputs a signal for controlling a four-stage stepping-motor.  The size of 

the panel to be assigned to the editing area is two stages (vertical).  By inputting 

information from the Enable section, the stepping motor is rotated (on) or stopped 

(off).  By inputting information from the Dir section, a signal for processing forward 

rotation (on) or reverse rotation (off) is output. 

 

Names of supported 

devices and boards 

78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, TK-78K0/KC2L 

- Assigned ports:  None (must be specified) Default properties 

- Rotation speed:  None (must be specified) 

- Excitation method:  None (must be specified) 

 Property settings of [Step motor] panel

Name Musical-scale output 

Function This panel outputs a square wave, which matches the specified musical scale of the 

input, from an output pin by using the square wave output function of a timer. 
 

μPD78F0534 to 78F0537 among 78K0/KE2 products, 78K0/KF2, 78K0R/KE3-L, TK-

78K0R/KE3L 

Names of supported 

devices and boards 

- Output pin:  P06/TI011/TO01 (for 78K0/KE2 and 78K0/KF2) Default properties 

 None (must be specified) (for 78K0R/KE3-L and  

 TK-78K0R/KE3L) 

- Musical output range: None (must be specified) 

Property settings of [Musical-scale output] panel 
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(b) [TK-78K0R/KE3L I/Os] and [TK-78K0/KC2L I/Os] tabs 

The properties of the output panels assigned to the pallet on the [TK-78K0R/KE3L I/Os] and [TK-

78K0/KC2L I/Os] tabs, such as the assigned ports, are specified by default, so the output devices on the 

evaluation board can be used as they are. 

Therefore, only the properties of the panels assigned to the output block area, which must be added or 

corrected, can be specified.  (The properties of assigned panels marked with a  mark in the editing area 

must be specified.) 

Only one instance of each panel on these tabs can be assigned to the output block area, and panels are 

displayed in gray after being assigned. 

 

[Caution] The ports assigned to each of the panels on this tab cannot be changed.  (Other default 

properties can be changed.) 

 

Table 6-5.  Output Panels ([TK-78K0R/KE3L I/Os] and [TK-78K0/KC2L I/Os] Tabs) 

Panel Description 

Name 7-segment display 

Function This panel represents the 7-segment LED jumper exit.  
It is used to light a 7-segment LED if the input is enabled. 

This panel is assigned with the [7-segment LED jumper] processing panel. 

To use a 7-segment LED, the display type must be prespecified by specifying the 

properties of this panel.  (The display of the [7-segment LED jumper] panel changes 

according to the specified display type.) 

Caution 7-segment LEDs of different display types cannot be used at the same 

time.  Therefore, if the display type is changed during editing by 

specifying the properties of this panel, the [7-segment LED jumper] 

panel already assigned to the editing area will be displayed as by 

default and the properties must be respecified. 

 

Names of supported 

boards 

TK-78K0R/KE3L, TK-78K0/KC2L 

- Assigned ports:  P00, P01, and P20 to P27 (for TK-78K0R/KE3L and  Default properties 

 TK-78K0/KC2L) 

- Display type:  None (must be specified) 

 Property settings of [7-segment display] panel

 

(c) [Other I/Os] tab 

The output panels assigned to the pallet on the [Other I/Os] tab are used to enable output devices not 

provided on the evaluation board for use. 

Only one instance of each panel on this tab can be assigned to the output block area, and panels are 

displayed in gray after being assigned. 

 

[Caution] The ports assigned to each of the panels on this tab cannot be changed. 
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Table 6-6.  Output Panels ([Other I/Os] Tab) 

Panel Description 

Name Buzzer 

Function This panel is used to sound the buzzer. 

By specifying multiple output frequencies in the properties, the panel is stretched 

vertically (up to three stages), the input is enabled for each output frequency, and a 

square wave of each specified frequency is output.  (The output frequencies are 

undefined if multiple inputs are enabled at the same time.) 

 

Names of supported 

devices and boards 

78K0/Kx2, 78K0/KC2-L, TK-78K0/KC2L 

- Assigned ports:  P15/TOH0 Default properties 
- Output frequency: None (must be selected from the specified values) 

 Property settings of [Buzzer] panel

Name 7-segment display 

Function This panel represents the 7-segment LED jumper exit.  
It is used to light a 7-segment LED if the input is enabled. 

This panel is assigned with the [7-segment LED jumper] processing panel. 

To use a 7-segment LED, the display type must be prespecified by specifying the 

properties of this panel.  (The display of the [7-segment LED jumper] panel changes 

according to the specified display type.) 

Caution 7-segment LEDs of different display types cannot be used at the same 

time.  Therefore, if the display type is changed during editing by 

specifying the properties of this panel, the [7-segment LED jumper] 

panel already assigned to the editing area will be displayed as by 

default and the properties must be respecified. 

 

Names of supported 

devices and boards 

78K0/KE2, 78K0/KF2 

- Assigned ports:  P06, P05, P17, P16, P12, P11, P10, P25 to P22 Default properties 

- Display type: None (must be specified) 

 Property settings of [7-segment display] panel

 

(4) Processing panels 

Processing panels can be assigned to the processing block area and include the following. 

 

(a) [Common] tab 

Whether the properties of the panels on the [Common] tab must be specified, depends on the type of 

processing. 

The properties of the panels assigned to the output block area must be specified, because their properties 

are not specified by default.  (The properties of assigned panels marked with a  mark in the editing area 

must be specified.) 

 

[Rotate] in the right-click menu is enabled depending on the panel type.  Use this item when editing the 

panels. 
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[Remark] By selecting any panel and pressing [Alt] and an arrow key after assigning the panels to the 

editing area, another instance of the same panel can be pasted at the same time such that it 

faces the direction of the arrow key (except for panels for which the size is displayed in multiple 

stages). 

 

Table 6-7.  Processing Panels 

Panel Description 

Name Wiring 

Function This panel transmits on or off information from the upper left panel connected to the 

panel to the lower right panel. 

Multiple instances of this panel can be assigned to the processing area. 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 
 

Name Jumper 

Function This panel represents the input (left) or output (left) of a jumper. 

This panel transmits on or off information from the jumper input that has the 

identification number (“n” below) specified in the properties to the jumper output that 

has the same number. 

The [Rotate] menu is enabled for this panel. 

Caution Multiple instances of the same jumper output that have the same 

identification number can be specified.  However, multiple instances 

of the same jumper input that have the same identification number 

cannot be specified. 

[[Jumper] panel displayed in the editing area] 

  /   :  If identification number n is specified 

 

Names of supported 

devices and boards 

All products 

Properties - Identification number 

 Property settings of [Jumper] panel

Name NC 

Function This panel is used when not connecting a panel. 

The [Rotate] menu is enabled for this panel. 
 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 

Name Logic 

Function This panel is used to perform an AND operation.  

The [Rotate] menu is enabled for this panel. 

 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 
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Panel Description 

Name Logic 

Function This panel is used to perform a NOT operation.  

The [Rotate] menu is enabled for this panel. 
 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 

Name Logic 

Function This panel is used to perform an OR operation.  

The [Rotate] menu is enabled for this panel. 
 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 

Name Logic 

Function This panel is used to perform an XOR operation. 

The [Rotate] menu is enabled for this panel. 
 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 

Name Logic 

Function This panel is used to always output an on (left) or off (right) signal. 

The [Rotate] menu is enabled for this panel. 

 

Names of supported 

devices and boards 

All products 

Properties Not required to be specified 

Name Comparator 

Function This panel is used to compare 4-bit or 8-bit values input from two sources, A and B. 

The comparison result is expressed by using three output signals, A > B, A < B, and A 

= B. 

If the input from A is greater than the input from B, the output signal “>” goes to the 

high level.  If the input from A is less than the input from B, the output signal “<” goes 

to the high level.  If the inputs from both A and B are equal, the output signal “=” goes 

to the high level. 

 

Names of supported 

devices and boards 

78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, TK-78K0/KC2L 

- Number of bits to be compared Properties 

 Property settings of [Comparator] panel
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Panel Description 

Name UART6 jumper output 

Function This panel represents the UART transmission jumper entrance.  

This panel is assigned with the [UART6 output] output panel. 

If 1 (on) or 0 (off) is input for the bit position that is the identification number of the 

jumper specified in the properties (“n” below), 1 or 0 is directly transmitted to the 

[UART6 output] panel in the output block area. 

[[UART6 jumper output] panel displayed in the editing area] 

 :  If identification number (bit position) n is specified 

Caution This panel is provided to secure compatibility with Applilet EZ PL V3.6 

or earlier. 

 

Names of supported 

devices and boards 

78K0S/KB1+, 78K0S/KA1+, 78K0/Kx2 

- Bit position Properties 

 Property settings of [UART6 jumper output] panel

Name UART0 jumper output 

Function This panel represents the UART transmission jumper entrance. 

This panel is assigned with the [UART0 output] output panel. 

If 1 (on) or 0 (off) is input for the bit position that is the identification number of the 

jumper specified in the properties (“n” below), 1 or 0 is directly transmitted to the 

[UART0 output] panel in the output block area. 

[[UART0 jumper output] panel displayed in the editing area] 

 :  If identification number (bit position) n is specified 

Caution This panel is provided to secure compatibility with Applilet EZ PL V3.6 

or earlier. 

 

Names of supported 

devices and boards 

78K0/Kx2 

- Bit position Properties 

 Property settings of [UART0 jumper output] panel

 

User’s Manual  U17656EJ6V0UM 57



CHAPTER  6   WINDOW  REFERENCE 

 

Panel Description 

Name 7-segment LED jumper 

Function This panel represents the 7-segment LED jumper entrance.  
This panel is assigned with the [7-segment display] output panel. 

The display type of the 7-segment LED can be specified by prespecifying the properties of the 

[7-segment display] panel. 

The information output from this panel is directly transmitted to the [7-segment display] panel in 

the output block area. 

Caution Panels of different display types cannot be used at the same time. 

 Therefore, if the display type is changed during editing by specifying the 

properties of the [7-segment display] panel, these panels, which are already 

assigned to the editing area, are displayed as by default and the properties must 

be respecified. 

The display of the panel changes as follows depending on the specified display type. 

 

Function Digit type 

Specify, in the properties, the digit or character displayed if an on signal is input. 

The character of the jumper entrance that has been enabled is displayed for the 

LED. 

Caution Caution must be exercised so that panels that have the same digit 

or character are not enabled at the same time. 

 

Properties - Displayed digit 

- Displayed value 

 Property settings of [7-segment LED jumper (digit type)] panel

Function Segment type 

Specify, in the properties, the digit or segment displayed if an on signal is input.  

Multiple segments can be specified by using one jumper. 
 

Properties - Displayed digit 

- Displayed segment 

 Property settings of [7-segment LED jumper (segment type)] panel

Function Bit type 

Specify, in the properties, the bit position of the binary data (8 or 16 bits) of the 

value to be displayed. 

Binary data is created assuming that the bit position of the enabled jumper input 

as 1, and that numeral is displayed for the LED. 

 

Properties - Bit position 

 Property settings of [7-segment LED jumper (bit type)] panel

Names of 

supported 

devices 

and boards 

78K0/KE2, 78K0/KF2, TK-78K0R/KE3L, TK-78K0/KC2L 
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Panel Description 

Name Flip-flop 

Function This panel operates as a flip-flop of the type specified in the properties. 

[[Flip-flop] panel displayed in the editing area] 

: If RS-FF, D-FF, T-FF, or JK-FF is specified 

 

Names of supported 

devices and boards 

All products 

- Operation type Properties 

 Property settings of [Flip-flop] panel

Name Counter 

Function This counter is incremented every time the clock input is disabled.  If the count value 

matches the value specified in the properties, the output is enabled. 

By specifying multiple values, the panel is stretched vertically (up to 15 stages) and 

multiple outputs can be processed. 

The initial value of the counter is 0.  Input from a higher block is assumed to be a 

reset signal and the counter is reset to the initial value. 

• Hold type: The counter stops at the maximum count value. 

• Cyclic type: The counter is reset at the maximum count value when a signal is 

input. 

Caution Edit panels by assigning up to 10 counter panels, timer panels, and 

delay panels in total.  If object code (*.hex) is automatically generated 

when using more than 10 panels, an error is output and compilation is 

aborted. 

 

Names of supported 

devices and boards 

All products 

Properties - Operation type 

- Set value 

 Property settings of [Counter] panel

Name Binary counter 

Function This 4-bit binary counter is incremented every time clock input C0 changes from 0 to 

1 while clock input C1 is 1 or clock input C1 changes from 1 to 0 while clock input C0 

is 0. 

If the master reset input MR is set to 1, all outputs will be 0. 

• BCD mode: The counter is incremented from 0 to 9.  The counter returns to 0 

after being incremented up to 9. 

• HEX mode:  The counter is incremented from 0 to 15 (F in hexadecimal).  The 

counter returns to 0 after being incremented up to F. 

 

Names of supported 

devices and boards 

All products 

- Operation type Properties 

 Property settings of [Binary counter] panel
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Panel Description 

Name Timer 

Function Hold type or toggle type

The output is enabled when the time specified in the properties elapses after the 

input is enabled. 

• Hold type: The on status is retained after the output is enabled. 

• Toggle type: On and off alternate in the specified time cycle after the output is 

enabled. 

One-shot type or one-shot (retriggerable) type 

The output is enabled when the input is enabled and the output is disabled after the 

specified time elapses. 

• Retriggerable type: The timer restarts when the input is enabled again while the 

output enabled. 

Caution Edit panels by assigning up to 10 counter panels, timer panels, and 

delay panels in total.  If object code (*.hex) is automatically generated 

when using more than 10 panels, an error is output and compilation is 

aborted. 

 

Names of supported 

devices and boards 

All products 

- Operation type Properties 
- Time 

 Property settings of [Timer] panel

Name Delay 

Function When the time specified in the properties elapses after the input signal changes, the 

same signal as that previously input is output. 

If the input signal changes before a signal is output, the time is measured again from 

that point.  Therefore, if the input signal is inverted within the specified time, the 

output signal does not change. 

Caution Edit panels by assigning up to 10 counter panels, timer panels, and 

delay panels in total.  If object code (*.hex) is automatically generated 

when using more than 10 panels, an error is output and compilation is 

aborted. 

 

Names of supported 

devices and boards 

All products 

Properties - Time 

 Property settings of [Delay] panel

Name Clock 

Function This panel has no input pins and is used to output the clock of the specified time. 

The function of this panel is equivalent to that of the [Timer] panel of the toggle type. 
 

Names of supported 

devices and boards 

All products 

- Pulse width Properties 

 Property settings of [Clock] panel
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Panel Description 

Name Stepping motor 

Function This panel outputs a signal for controlling a four-stage stepping-motor.  The size of 

the panel to be assigned to the editing area is four stages (vertical).  By inputting 

information from a higher block, the stepping motor is rotated (on) or stopped (off).  

By inputting information from the left block, a signal for processing forward rotation 

(on) or reverse rotation (off) is output. 

Caution Edit this panel by assigning only one panel.  If object code (*.hex) is 

automatically generated when assigning multiple panels, an error is 

output and compilation is aborted. 

 

Names of supported 

devices and boards 

78K0S/Kx1+ 

- Rotation speed Properties 
- Excitation method 

 Property settings of [Stepping motor] panel

Name Reset 

Function This panel is used to reset the system by using the watchdog timer. 

Caution Settings must be specified in the Watchdog Timer Setting dialog box 

before using this panel. 

 

Names of supported 

devices and boards 

All products 

Properties - Valid input value 

 Property settings of [Reset] panel
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(b) [74 Series] tab 

The panels on the [74 Series] tab operate similarly to a 74HCxx logic IC. 

 

Panel Function Panel Function 

2-input NAND 2-input NOR 
  

3-input NAND 3-input AND 
  

4-input NAND 4-input AND 
  

3-input NOR 8-input NAND 
  

2/3-input AND-OR-NOT 4-bit bistable latch 
  

J-K FF with clear, preset and clock 13-input NAND 
  

3-to-8 line decoder 8-to-3 priority line encoder 
  

4-channel multiplexer 8-bit parallel-in/serial-out shift register 
  

9-bit parity generator 4-bit binary full adder 
  

4-input NOR 4-input OR 
  

3-input OR 8-input OR/NOR 
  

BCD-to-7-segment latch 2-input XNOR 
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Editing panels 

 

(1) Assigning panels from the pallet 

Input panels, Processing panels, and Output panels can be assigned to the editing area in the following two 

ways. 

(a) Left-clicking a panel on the pallet, moving the mouse cursor to the location in the editing area to which to 

assign the panel, and then left-clicking again 

(b) Left-clicking a panel on the pallet, moving the mouse cursor to the location in the editing area to which to 

assign the panel, and then releasing the left mouse button (dragging and dropping) 

 

[Caution 1] When using method (a), the panel selected on the pallet remains selected even after it is 

assigned.  Therefore, repeatedly click the left mouse button in the editing area to assign 

multiple instances of that panel.  To deselect the panel, left-click the panel again or left-

click different panel. 

 

[Caution 2] Assign panels so that the ROM size does not exceed the size of the flash ROM provided 

in the product.  (Watch the Status bar when assigning panels [Note].) 

 

[Note]  The estimated ROM size differs from the result of actual compilation. 

 

[Caution 3] When editing, assign no more than ten instances of the processing panels below, total.  If 

object code (*.hex) is automatically generated when using more than 10 panels, an error 

is output and compilation is aborted. 

 

     
 

[Caution 4] If an attempt is made to assign a panel to a location where panels cannot be assigned, 

the operation is ignored. 

 If an attempt is made to assign a panel to a location where a panel whose properties are 

already specified is already assigned, a message to confirm whether to overwrite the 

existing panel is displayed.  The existing panel is overwritten only if [OK] is clicked. 

 

(2) Repeatedly assigning panels 

Multiple instances of the same panel can be assigned by clicking a panel and dragging it into the editing area. 

 

(3) Selecting multiple panels 

Multiple panels can be selected by holding down [Ctrl] while dragging a panel in the editing area.  (The 

selected range is indicated by a red frame.) 

However, panels of different types (input, processing, and output panels) cannot be selected at the same time.  

Panels that have multiple stages cannot be selected unless all stages are included in the selected range. 

 

(4)  Copying, cutting, and pasting panels 

The following operations can be performed in the editing area. 

 

(a) Copying 

To copy a panel or multiple panels in the selected range to the internal buffer, select a panel or panels, 
click the [Edit] menu, and then click [Copy] in the right-click menu, or click . 
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(b) Cutting 

To copy a panel or panels in the selected range to the internal buffer and then delete them from the editing 

area, select a panel or panels, click the [Edit] menu, and then click [Cut] in the right-click menu, or click 

. 

 

(c) Pasting 

To paste the panel information in the internal buffer to the selected location, click the [Edit] menu, and then 

click [Paste] in the right-click menu, or click . 

If multiple panels have been copied to the internal buffer, paste the panel information to the location to the 

left and above the desired location.  However, if the selected range is smaller than the copied range, the 

panel information cannot be pasted. 

If a panel already exists at the desired location, the following message to select which processing to use is 

displayed. 

 

Figure 6-3.  Confirmation Message Displayed if a Panel Exists at the Desired Location 

 

 
 

Select the processing from the following. 

[Yes]:  Replace all pasted panels.  (Delete all specified properties.) 

[No]:  Paste the panel information only to locations where panels have not been pasted. 

[Cancel]:  Do not paste the panel information. 

 

(5) Moving panels 

Panels assigned to the editing area can be moved by dragging and dropping them.  If panels whose properties 

are specified already exist at the location to which you want to move the panels, a message asking whether to 

overwrite the existing panels is displayed.  The panels are moved only if [OK] is clicked. 

 

(6) Deleting panels 

Panels assigned to the editing area can be deleted by selecting the panels to delete, and then taking one of 

the actions below. 

However, if a panel whose properties are specified is included in the panels to delete, a message asking 

whether to delete the panel is displayed.  The panel is deleted only if [OK] is clicked. 

 

• Clicking [Delete] in the right-click menu 

• Dragging and dropping the panels outside the editing area 

• Pressing the [Delete] key 

• Clicking the [Edit] menu, and then [Delete] 
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(7) Rotating panels 

The I/O direction of the processing panels below can be changed by selecting [Rotate] in the right-click menu 

in the editing area.  The I/O direction is switched each time [Rotate] is selected. 

 

 
 

(8) Shifting panels vertically 

All panels assigned to the editing area can be shifted to the row above or below by clicking the [Edit] menu, 

[Move All Panels], and then [To Upper] or [To Lower]. 

If this operation is performed, the panels assigned to the top or bottom row is deleted. 

 

(9) Shifting panels horizontally 

The processing panels assigned to the editing area can be shifted to the column to the right or left by clicking 

the [Edit] menu, [Move All Panels], and then [To Right] or [To Left].  (Input and output panels are not shifted.) 

If this operation is performed, the processing panels assigned to the rightmost or leftmost column is deleted. 

 

(10) Specifying properties 

The properties of the panels assigned to the editing area during editing must be specified.  (Properties do not 

have to be specified for some panels.) 

Specify or change the properties in the Property Settings dialog box opened by performing one of the 

operations below.  (For details about the items to specify, see the description of the relevant panel in the 

section describing the Property Settings dialog box.) 

• Click the target panel, the [Edit] menu, and then [Show Panel’s Property]. 

• Click the target panel and then [Property setting] in the right-click menu. 

• Double-click the target panel. 

However, if the target panel is double-clicked while another panel is selected, the target panel will be 

overwritten by the selected panel.  Therefore, make sure to deselect the selected panel before double-clicking 

the target panel.  

 

(11) Changing the panel size by specifying the properties 

By specifying the properties, the following panels are stretched vertically and become capable of handling 

multiple input or output signals by using one panel. 

However, if panels are already assigned to the blocks to be occupied by changing the size of a panel, the 

specified properties will be invalid and the panel size will not change.  Therefore, the required number of vacant 

blocks must be secured in advance. 

 

  
  : Up to 10 stages depending on the specified value (compare type) 

 : Up to 8 stages depending on the number of output bits (bit type) 
 

 : Up to 3 stages depending on the number of output frequencies 
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   : 3 or 5 stages, or up to 15 stages depending on the number of duty factors 

 : Fixed to 2 stages for the Enable and Dir input signals 

 : Up to 37 stages depending on the musical output range 

 : Up to 3 stages depending on the operation type 

 : Up to 15 stages depending on the counter setting 

 

(12) Displaying information about the corresponding jumpers 

If Jumper panels are used in the processing area, supplementary lines that indicate the correspondence 

among the jumper panels and other panels according to the identification numbers specified in the jumper 

panel properties can be temporarily displayed by clicking [Jumper Relation] in the right-click menu.  (Nothing is 

displayed if corresponding jumper panels do not exist or the identification numbers are not specified in the 

jumper panel properties.) 

The supplementary lines are deleted by clicking any panel in the editing area. 

 

Figure 6-4.  Example of the Displayed Correspondence of Jumpers 

 

 
 

 

(13) Clearing all panels 

All panels assigned to the editing area can be cleared (deleted) by clicking the [File] menu and then [New], or 
by clicking  on the toolbar. 

If panels are cleared during editing, a confirmation message that the edited contents will be deleted is 

displayed.  All panels are cleared only if [OK] is clicked. 

 

(14) Undoing 

An operation to paste panels, move panels, delete panels, shift panels, or specify or change the properties of 

panels can be reversed once by clicking the [Edit] menu, and then [Undo]. 

However, an operation performed by clicking the [File] menu and then [New], or by clicking  on the toolbar, 

cannot be reversed. 
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Saving and reading data 
 

(1) Saving data 

The current status of editing (the types, locations, and properties of all panels in the editing area) can be saved 
to a panel location file (*.loc) by clicking the [File] menu and then [Save as…] or [Save], or by clicking  on 

the Toolbar. 

 

(2) Reading data 

An existing panel location file (*.loc) can be read to reproduce the previous status (the types, locations, and 
properties of all panels in the editing area) by clicking the [File] menu and then [Open…], or by clicking  on 

the Toolbar. 

During editing, a confirmation message is displayed, and the panel location file (*.loc) is read to reproduce the 

previous status only if [OK] is clicked. 

 

 

Automatically generating object code and writing to flash memory 
 

To perform compilation that automatically generates object code (*.hex) that handles the current panel assignment 
as one sequence, click the [Run] menu and then [Build & Write], or click  on the Toolbar. 

If compilation ends normally, the flash memory provided in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 

78K0/KC2-L is written to. 

The operation to write to the flash memory differs depending on the target CPU settings.  If a supported evaluation 

board is used, writing to the flash memory is started by clicking [OK] after compilation ends, because the flash 

memory programmer provided in Applilet EZ PL is used.  If a device is selected in the target CPU settings, use the 

software GUI for the flash memory programmer to be used to write to the flash memory after compilation ends. 

The object code (*.hex) to be written to the flash memory is automatically generated in the folder in which the target 

panel location file is saved. 
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During compilation or writing to the flash memory, the following dialog box automatically opens and the execution 

status is displayed. 

If an error occurs at this time, a description of the error is displayed and compilation is aborted.  (For details about 

errors, see CHAPTER 7  ERROR MESSAGES.) 

 

Figure 6-5.  Example of the Execution Status Displayed During Compilation or Writing to the Flash Memory 

 

 
 

[Caution 1] When editing panels, object code (*.hex) cannot be generated until the panel location file 

(*.loc) is saved. 

 During compilation, Applilet EZ PL automatically generates object code (*.hex) by saving the 

information about the current panel assignment to a temporary panel location file (*.loc) and 

then referencing that file. 

 Therefore, if compilation is executed without saving the information about the current panel 

assignment after editing panels, the saved panel location file (*.loc) and generated object code 

(*.hex) might not match. 

 

[Caution 2] If any of the following conditions are not satisfied, Applilet EZ PL will output an error when 

automatically generating object code (*.hex) and abort compilation: 

• The required properties of all assigned panels are specified.  (The  mark indicates that the 

properties of the marked panel have not been fully specified.) 

• All assigned panels are wired.  (Delete the panels not to be used from the editing area.) 

• No ports are specified more than once in the properties of I/O panels.  (This can be checked 

in the Port Setting dialog box.) 

• The ROM size does not exceed the size of the flash ROM provided in the product.  (This can 

be checked in the Status bar [Note].) 

• No more than 10 instances of the [Counter], [Timer], and [Delay] panels are assigned in total 

(only for the 78K0S/Kx1+). 

 

[Note]  The estimated ROM size differs from the result of actual compilation. 
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[Caution 3] If using a supported evaluation board, turn on the power of the evaluation board and specify a 

mode in which data can be written to the flash memory before writing to the flash memory.  

When writing to the flash memory ends, switch the mode to normal operation mode, and then 

press the reset switch to operate the microcontroller. 

 

[Caution 4] Make sure that the evaluation board and host are connected via the provided USB cable.  (See 

3.2.1  Installing software.) 

 

Right-click menu 
 

The following menu items are displayed by right-clicking on a panel assigned to the editing area. 

 

[Rotate] This changes the I/O direction of the target panel.  The I/O direction is switched each time this menu item 

is selected. 

This menu item cannot be selected for some panel types. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then 

[Rotate]. 

[Cut] This copies one or more panels in the currently selected range to the internal buffer, and then deletes the 

panels from the editing area. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then [Cut], 

or by clicking  on the toolbar. 

[Copy] This copies one or more panels in the currently selected range to the internal buffer. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then 

[Copy], or by clicking  on the toolbar. 

[Paste] This pastes the panels copied to the internal buffer to the selected location. 

If multiple panels have been copied to the internal buffer, the panels are pasted to the left and above the 

desired location.  However, if the selected range is smaller than the copied range, the panel information 

cannot be pasted. 

If a panel already exists at the desired location, a message to select which processing to use is 

displayed.  (See (4)  Copying, cutting, and pasting panels.) 

This menu item cannot be selected if no information exists in the internal buffer. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then 

[Paste], or by clicking  on the toolbar. 

[Delete] This deletes the currently selected panels from the editing area. 

If the properties of the panels to be deleted are specified, the properties are also deleted. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then 

[Delete]. 
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[Jumper Relation] This temporarily displays supplementary lines that indicate the correspondence among the currently 

selected jumper panels and other panels according to the identification numbers specified in the 

jumper panel properties.  Nothing is displayed if the corresponding jumper panels do not exist or the 

identification numbers are not specified in the jumper panel properties. 

The supplementary lines are deleted by clicking any panel in the editing area. 

This menu item cannot be selected if a panel other than a jumper panel is selected. 

[Property setting…] This opens the Property Settings dialog box for the target panel. 

The function of this menu item is equivalent to that performed by clicking the [Edit] menu and then 

[Show Panel’s Property]. 

This displays details about the target panel in the help area. [Description] 

The function of this menu item is equivalent to that performed by clicking the [Help] menu and then 

[Panel Description]. 

 

 

Menu bar 
 

(1) [File] menu 

 

[New] This starts a new edit. 

During editing, a message indicating that the edited contents are erased will be displayed.  A new editing 

window is displayed only if [OK] is clicked. 

 on the toolbar. The function of this menu item is equivalent to that performed by clicking 

[Open…] This reads an existing panel location file (*.loc) and reproduces the previous status (the types, locations, and 

properties of all panels in the editing area). 

 on the toolbar. The function of this menu item is equivalent to that performed by clicking 

This saves the current status (the types, locations, and properties of all panels in the editing area) to a panel 

location file (*.loc). 

[Save] 

 on the toolbar. The function of this menu item is equivalent to that performed by clicking 

This saves the current status (the types, locations, and properties of all panels in the editing area) to a new 

panel location file (*.loc). 
[Save as…] 

This prints a screenshot of the current panel assignment and information about the properties of each panel 

(the assigned location, panel name, and property values). 

[Print…] 

 on the toolbar. The function of this menu item is equivalent to that performed by clicking 

This displays a print preview of a screenshot of the current panel assignment and information about the 

properties of each panel (the assigned location, panel name, and property values). 
[Preview] 

This specifies the printer to be used and the printer options. [Print Setup…] 

[Recently Used 

Files] 

This displays up to four files that have recently been used. 

This closes Applilet EZ PL. [Exit] 
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(2) [Edit] menu 

 

[Undo] This reverses an operation such as pasting, moving, deleting, shifting, or specifying or changing 

the properties of a panel to the original status only once. 
However, the operation performed by clicking the [File] menu and then [New], or by clicking  

on the toolbar cannot be reversed. 
 on the toolbar. The function of this menu item is equivalent to that performed by clicking 

[Cut] This copies one or more panels in the currently selected range to the internal buffer, and then 

deletes the panels from the editing area. 

The function of this menu item is equivalent to that performed by clicking [Cut] in the right-click 

menu, or by clicking  on the toolbar. 

This copies one or more panels in the currently selected range to the internal buffer. [Copy] 

The function of this menu item is equivalent to that performed by clicking [Copy] in the right-click 

menu, or by clicking  on the toolbar. 

This pastes the panels copied to the internal buffer to the selected location. [Paste] 

If multiple panels have been copied to the internal buffer, the panels are pasted to the left and 

above the desired location.  However, if the selected range is smaller than the copied range, an 

error message indicating that the panel information cannot be pasted is displayed. 

If a panel already exists at the desired location, a message to select which processing to use is 

displayed.  (See (4)  Copying, cutting, and pasting panels.) 

This menu item cannot be selected if no information exists in the internal buffer. 

The function of this menu item is equivalent to that performed by clicking [Paste] in the right-click 

menu, or by clicking  on the toolbar. 

This deletes the currently selected panels from the editing area. [Delete] 

If the properties of the panels to be deleted are specified, the properties are also deleted. 

The function of this menu item is equivalent to that performed by clicking [Delete] in the right-

click menu. 

This changes the I/O direction of the target panel.  The I/O direction is switched each time this 

menu item is selected. 

[Rotate] 

This menu item cannot be selected for some panel types. 

The function of this menu item is equivalent to that performed by clicking [Rotate] in the right-

click menu. 

This displays the next cascade menu. [Move All Panels] 

This shifts all panels assigned to the editing area to the row above, deleting panels assigned to 

the top row. 

[To Upper]  

This shifts all panels assigned to the editing area to the row below, deleting panels assigned to 

the bottom row. 

[To Lower] 

This shifts the processing panels assigned to the editing area to the row to the right (I/O panels 

are not shifted), deleting processing panels assigned to the rightmost row. 

[To Right] 

This shifts the processing panels assigned to the editing area to the row to the left (I/O panels 

are not shifted), deleting processing panels assigned to the leftmost row. 

[To Left] 

Property Settings dialog box for the currently selected panel. This opens the [Show Panel’s Property] 

The function of this menu item is equivalent to that performed by clicking [Property setting] in the 

right-click menu. 
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(3) [View] menu 

 

This opens the Port Setting dialog box that displays a list of the I/O ports currently 

specified in the property settings. 

[Assigned ports…] 

Build, simulation, and help areas are displayed by selecting this item (displayed by 

default). 

[Output Window] 

Toolbar is displayed by selecting this item (displayed by default). [Toolbar] 

 

(4) [Run] menu 

 

This performs compilation that automatically generates object code (*.hex) that handles the 

current panel assignment as a processing sequence. 

[Build & Write] 

If compilation ends normally, the flash memory provided in the 78K0/Kx2, 78K0S/Kx1+, 

78K0R/KE3-L, or 78K0/KC2-L can be written successively. 

The object code (*.hex) is automatically generated in the same folder as the panel location 

file (*.loc).  Therefore, when editing panels, this menu item cannot be used until data is 

saved. 
The function of this menu item is equivalent to that performed by clicking  on the 

toolbar. 

This can be used to simulate a created program by using Applilet EZ PL before 

compilation. 
[Start simulation] 

[Stop simulation] is displayed during simulation. 

The function of this menu item is equivalent to that performed by clicking  on the 

toolbar. 

[Caution] If any of the following conditions are not satisfied, Applilet EZ PL will output an error when 

automatically generating object code (*.hex) and abort compilation: 

• The required properties of all assigned panels are specified.  (The  mark indicates that 

the properties of the marked panel have not been fully specified.) 

• All assigned panels are wired.  (Delete the panels not to be used from the editing area.) 

• No ports are specified more than once in the properties of I/O panels.  (This can be 

checked in the Port Setting dialog box.) 

• The ROM size does not exceed the size of the flash ROM provided in the product.  (This 

can be checked in the Status bar [Note].) 

• No more than 10 instances of the [Counter], [Timer], and [Delay] panels are assigned in 

total (only for the 78K0S/Kx1+). 

 

[Note]  The estimated ROM size differs from the result of actual compilation. 

User’s Manual  U17656EJ6V0UM 72 



CHAPTER  6   WINDOW  REFERENCE 

(5) [Settings] menu 

 

Target CPU Settings dialog box[Target CPU…] This opens the  used for selecting the device or 

board and system clock source to be used. 

[CPU Function…] This displays the next cascade menu. 

[Watchdog timer…] This selects the use of the watchdog timer and opens the Watchdog Timer Setting 

dialog box in which to specify settings. 
 

UART0 Settings dialog boxThis opens the  in which to specify the properties of the 

UART0 I/Os. 

[UART0…] 

UART1 Settings dialog boxThis opens the  in which to specify the properties of the 

UART1 I/Os. 

[UART1…] 

UART6 Settings dialog boxThis opens the  in which to specify the properties of the 

UART6 I/Os. 

[UART6…] 

Flash Memory Programmer Settings dialog boxThis opens the  in which to specify the 

COM port used for writing to the flash memory provided in the 78K0/Kx2, 

78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L. 

[FLASH memory programmer…] 

[Folders…] This opens the Saved Data Folder dialog box in which to specify where to save data. 

 

(6) [Help] menu 

 

[Show User’s Manual…] This displays the Applilet EZ PL User’s Manual. 

[Panel Description] This displays details about the target panel in the help area. 

This displays the Applilet EZ PL version in the order of the “Product Name”, “Version 

Number”, and “Copyright Year”. 

[Version…] 
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Toolbar 
The following buttons on the toolbar can be used to execute frequently used menu items just by clicking once. 

 

Table 6-8.  Functions of Toolbar Buttons 

Button Function 

The function of this button is equivalent to that performed by clicking the [File] menu and then [New]. 

 

The function of this button is equivalent to that performed by clicking the [File] menu and then [Open…]. 

 

The function of this button is equivalent to that performed by clicking the [File] menu and then [Save]. 

 

The function of this button is equivalent to that performed by clicking the [File] menu and then [Print…]. 

 

The function of this button is equivalent to that performed by clicking the [File] menu and then [Preview]. 

 

The function of this button is equivalent to that performed by clicking the [Edit] menu and then [Cut], or by clicking 

[Cut] in the right-click menu. 
 

The function of this button is equivalent to that performed by clicking the [Edit] menu and then [Copy], or by clicking 

[Copy] in the right-click menu. 
 

The function of this button is equivalent to that performed by clicking the [Edit] menu and then [Paste], or by clicking 

[Paste] in the right-click menu. 
 

The function of this button is equivalent to that performed by clicking the [Edit] menu and then [Undo]. 

 

The function of this button is equivalent to that performed by clicking the [Run] menu and then [Start simulation] 

when simulation is stopped. 
 

The function of this button is equivalent to that performed by clicking the [Run] menu and then [Stop simulation] 

during simulation. 
 

The function of this button is equivalent to that performed by clicking the [Run] menu and then [Build & Write]. 
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Status bar 
The following information is displayed on the status bar. 

 

Figure 6-6.  Status Bar Example 

 
 

(1)  Panel property values (2)  Currently selected location  

  (3)  Estimated amount of used ROM

 

(1)  Panel property values 

The name and property values of the panel on which the mouse cursor is currently placed in the editing area 

are displayed.  However, these are not displayed for a panel whose properties cannot be specified. 

 

(2)  Currently selected location 

The location currently selected in the editing area is displayed in this field as coordinates. 

The coordinates represent the values on the horizontal and vertical axes, with the top-left corner of each area 

as the origin. 

However, for the input and output block areas, the values on the horizontal axis will be fixed to “IN” and “OUT”, 

respectively. 

[Example] Input block area: “IN, yy” 

 Output block area: “OUT, yy” 

 

(3)  Estimated amount of used ROM 

The estimated amount of used ROM is displayed in this field. 

The value is rounded to the nearest KB.  (If the used amount is estimated as 0.2 KB, 1 KB is displayed.) 

If object code (*.hex) is automatically generated, the estimated value is corrected and then displayed in the 

build area.  The estimated amount is only a benchmark.  For the actually generated size, see the value 

displayed in the execution status display window when object code is automatically generated or data is written 

to flash memory, or see the generated map file. 
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Property Settings dialog box 
 

This dialog box is used to specify the properties of the panels to be assigned to the editing area in the Main window. 

The appearance of the dialog box differs for each panel, because the specifiable properties differ for each panel 

type. 

This dialog box is opened by performing one of the following operations in the editing area in the Main window. 

• Click the target panel, the [Edit] menu, and then [Show Panel’s Property]. 

• Double-click the target panel. 

• Click the target panel and then [Property setting] in the right-click menu. 

 

Figure 6-7.  Example of the Property Settings Dialog Box (for the [Push Button] Panel) 

 
 

The following items are described below: 

• Function buttons

• Details of the Property Settings dialog boxes

 

Function buttons 
 

Button Function 

Applies the settings as properties of the selected panel and closes the dialog box. 

However, this button cannot be selected if the required items are not specified.  

Does not apply the settings and closes the dialog box. 
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Details of the Property Settings dialog boxes 
Details of the dialog boxes for specifying the properties for input, output, and processing panels are provided below. 

The correspondence among each panel and the corresponding Property Settings dialog box is shown below. 

 

Table 6-9.  Property Settings Dialog Boxes 

Panel Type Tab Name Panel How to Specify the Properties 

 

Property settings of [Digital input] panelInput panels [Common] 

Property settings of [Analog input] panel

 

Property settings of [UART6 input] panel

 

Property settings of [UART0 input] panel

 

Property settings of [UART1 input] panel

 

Property settings of [LVI] panel

 

Property settings of [Push button] panel

 

[TK-78K0R/KE3L I/Os] and 

[TK-78K0/KC2L I/Os] 

Property settings of [DIP switch] panel

 

Property settings of [Analog input (illuminance)] panel
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Panel Type Tab Name Panel How to Specify the Properties 

 

Property settings of [Digital output] panelOutput 

panels 

[Common] 

Property settings of [Simple PWM] panel

 

Property settings of [PWM output] panel

 

Property settings of [UART6 output] panel

 

Property settings of [UART0 output] panel

 

Property settings of [UART1 output] panel

 

Property settings of [Step motor] panel

 

Property settings of [Musical-scale output] panel

 

 

Property settings of [Buzzer] panelOutput 

panels 

[TK-78K0R/KE3L I/Os] and 

[TK-78K0/KC2L I/Os] 

Property settings of [7-segment display] panel

 

Property settings of [Musical-scale output] panel

 

 

Property settings of [Buzzer] panelOutput 

panels 

[Other I/Os] 

Property settings of [7-segment display] panel
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Panel Type Tab Name Panel How to Specify the Properties 

− 

 

Property settings of [Jumper] panelProcessing 

panels 

− Property settings of [Comparator] panel

 

− Property settings of [UART6 jumper output] panel 

[Note]  

− Property settings of [UART0 jumper output] panel 

[Note]  

− Property settings of [7-segment LED jumper (digit type)] 

panel 

− Property settings of [7-segment LED jumper (segment 

type)] panel 

− Property settings of [7-segment LED jumper (bit type)] 

panel 

− Property settings of [Flip-flop] panel

 

− Property settings of [Counter] panel

 

− Property settings of [Binary counter] panel

 

− Property settings of [Timer] panel

 

− Property settings of [Delay] panel

 

− Property settings of [Clock] panel

 

− Property settings of [Stepping motor] panel

 

− Property settings of [Reset] panel

 

 

[Note] This panel is provided to secure compatibility with Applilet EZ PL V3.6 or earlier. 
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The property settings for Applilet EZ PL are described in the format below.  (How to specify the properties in the 

property settings of [digital input] panel is shown below as an example.) 

 

 

 

 

Input panel Property settings of [Digital input] panel   

 

 All products 

A screenshot of the Property Settings dialog box 

showing the items to be specified is shown. 

Panel 
The name of the panel whose properties are to 

be specified is shown in square brackets. 

Panel type 

(input, output, or processing panel)

 

 

 

 

Targets 

(names of products supporting this panel) 
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Input panel Property settings of [Digital input] panel   

 

 All products 

 

Figure 6-8.  Property Settings Dialog Box (for the [Digital Input] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 

 

(2) Assigned Port(P): 

Select the port to assign as the input pin from the drop-down list. 

Make sure not to select a port that was already assigned by specifying the properties of another panel. 

 

(3) Active Level(L): 

Select H (high) or L (low) as the active level from the drop-down list.  (H is selected by default.) 

 

(4) Chattering reduction 

Specify whether to eliminate chattering. 

If the checkbox is selected, the time for eliminating chattering can be selected from 10, 20, 30, 40, 50, 60, 70, 

80, 90, and 100 ms (not selected by default). 
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Input panel Property settings of [Analog input] panel   

 

 μPD78F92xx (from among the 78K0S/Kx1+ products), 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L,  

TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-9.  Property Settings Dialog Box (for the [Analog Input] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 

 

(2) Assigned Port(P): 

Select the port to assign as the input pin from the drop-down list. 

Make sure not to select a port that was already assigned by specifying the properties of another panel. 

 

(3) Opamp Rate(A): 

Multiplication by 4, 6, 8, 10, or 12 can be selected if P80/CMP0P/INTP3/OAI is selected as the assigned port 

for the 78K0R/KE3-L or TK-78K0R/KE3L. 

Multiplication by 4, 8, 16, or 32 can be selected if P21/ANI1/AMP0OUT/PGAIN is selected as the assigned port 

for the 78K0/KC2-L or TK-78K0/KC2L. 
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(4) Selecting the type 

Select either type by using the option buttons, and then specify the required values (not specified by default). 

 

(a) Compare mode(C): Value: 

If the A/D converted values are at least these specified values, output is enabled. 

However, if the “In Range” checkbox is selected, output is enabled if A/D converted values are in the range 

of the specified values. 

If multiple values are specified, the panel is stretched vertically (up to 10 stages) according to the specified 

values and the output of each specified value is passed to the processing block. 

Up to 10 values in the range from 0 to 255 can be specified.  (Values outside the range and identical 

values are ignored.) 

 

(b) Bit mode(B): Number of Bits: 

Each bit of the A/D converted values is enabled and output if the number of output bits is 1.  The panel is 

stretched vertically (up to 8 stages) according to the specified number of output bits and the output of each 

bit is passed to the processing block. 

From the drop-down list, select how many of the higher bits (1 to 8) to output. 

 

User’s Manual  U17656EJ6V0UM 83



CHAPTER  6   WINDOW  REFERENCE 

Input panel Property settings of [UART6 input] panel   

 

 78K0S/KB1+, 78K0S/KA1+, 78K0/Kx2, 78K0/KC2-L, and TK-78K0/KC2L 

 

Figure 6-10.  Property Settings Dialog Box (for the [UART6 Input] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 
 

(2) Assigned Port(P): 

The RxD6 pin is fixed as the input pin (and cannot be changed). 
 

(3) Selecting the types 

Select either type by using the option buttons, and then specify the required values (not specified by default). 
 

(a) Compare mode(C): Value: 

If the received data matches the specified values, output is enabled.  If multiple values are specified, the 

panel is stretched vertically (up to 10 stages) according to the specified values and the output of each 

specified value is passed to the processing block. 

Up to 10 values in the range from 0 to 255 can be specified.  (Values outside the range and identical 

values are ignored.) 
 

(b) Bit mode(B): Number of: 

Each bit of received data is enabled and output if the number of output bits is 1.  The panel is stretched 

vertically (up to 8 stages) according to the specified number of output bits and the output of each bit is 

passed to the processing block. 

From the drop-down list, select how many of the higher bits (1 to 8) to output. 
 

[Remark] Check the communication parameters in the UART6 Settings dialog box. 
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Input panel Property settings of [UART0 input] panel   

 

 78K0/Kx2, 78K0R/KE3-L, and TK-78K0R/KE3L 

 

Figure 6-11.  Property Settings Dialog Box (for the [UART0 Input] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 
 

(2) Assigned Port(P): 

The RxD0 pin is fixed as the input pin (and cannot be changed). 
 

(3) Selecting the type 

Select either type by using the option buttons, and then specify the required values (not specified by default). 
 

(a) Compare mode(C): Value: 

If the received data matches the specified values, output is enabled.  If multiple values are specified, the 

panel is stretched vertically (up to 10 stages) according to the specified values and the output of each 

specified value is passed to the processing block. 

Up to 10 values in the range from 0 to 255 can be specified.  (Values outside the range and identical 

values are ignored.) 
 

(b) Bit mode(B): Number of: 

Each bit of received data is enabled and output if the number of output bits is 1.  The panel is stretched 

vertically (up to 8 stages) according to the specified number of output bits and the output of each bit is 

passed to the processing block. 

From the drop-down list, select how many of the higher bits (1 to 8) to output. 
 

[Remark] Check the communication parameters in the UART0 Settings dialog box. 
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Input panel Property settings of [UART1 input] panel   

 

 78K0R/KE3-L and TK-78K0R/KE3L 

 

Figure 6-12.  Property Settings Dialog Box (for the [UART1 Input] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 
 

(2) Assigned Port(P): 

The RxD1 pin is fixed as the input pin (and cannot be changed). 
 

(3) Selecting the type 

Select either type by using the option buttons, and then specify the required values (not specified by default). 
 

(a) Compare mode(C): Value: 

If the received data matches the specified values, output is enabled.  If multiple values are specified, the 

panel is stretched vertically (up to 10 stages) according to the specified values and the output of each 

specified value is passed to the processing block. 

Up to 10 values in the range from 0 to 255 can be specified.  (Values outside the range and identical 

values are ignored.) 
 

(b) Bit mode(B): Number of: 

Each bit of received data is enabled and output if the number of output bits is 1.  The panel is stretched 

vertically (up to 8 stages) according to the specified number of output bits and the output of each bit is 

passed to the processing block. 

From the drop-down list, select how many of the higher bits (1 to 8) to output. 
 

[Remark] Check the communication parameters in the UART1 Settings dialog box. 
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Input panel Property settings of [LVI] panel   

 

 78K0S/Kx1+, 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-13.  Property Settings Dialog Box (for the [LVI] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage). 

This item can be omitted. 

 

(2) Terminal(T): 

Select the pin to use from the drop-down list. 

VDD or EXLVI (except when using the 78K0S/Kx1+) can be selected. 

 

(3) Voltage level(V): 

This item is enabled if the voltage detection pin is specified. 

Select the value of the detection level from the drop-down list. 
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Input panel Property settings of [Push button] panel   

 

 TK-78K0R/KE3L and TK-78K0/KC2L 

 

Figure 6-14.  Property Settings Dialog Box (for the [Push Button] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage). 

This item can be omitted. 

 

(2) Assigned Port(P): 

Fixed to the port assigned to the device (and cannot be changed). 

 

(3) Active Level(L): 

Select H (high) or L (low) as the active level from the drop-down list. 

 

(4) Chattering reduction 

Specify whether to eliminate chattering. 

If the checkbox is selected, the time for eliminating chattering can be selected from 10, 20, 30, 40, 50, 60, 70, 

80, 90, and 100 ms (specified as 30 ms by default). 

 

[Remark] The default values of the items in this dialog box differ depending on the panel.  (For details, see Table 

6-2 Input Panels ([Common] Tab) Table 6-3  and Input Panels ([TK-78K0R/KE3L I/Os] and [TK-

78K0/KC2L I/Os] Tabs).) 
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Input panel Property settings of [DIP switch] panel   

 

 TK-78K0R/KE3L and TK-78K0/KC2L 

 

Figure 6-15.  Property Settings Dialog Box (for the [DIP Switch] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage). 

This item can be omitted. 

 

(2) Assigned Port(P): 

Fixed to the port assigned to the device (and cannot be changed). 

 

(3) Active Level(L): 

Select H (high) or L (low) as the active level from the drop-down list. 

 

(4) Chattering reduction 

Specify whether to eliminate chattering. 

If the checkbox is selected, the time for eliminating chattering can be selected from 10, 20, 30, 40, 50, 60, 70, 

80, 90, and 100 ms (specified as 50 ms by default). 

 

[Remark] The default values of the items in this dialog box differ depending on the panel.  (For details, see Table 

6-2 Input Panels ([Common] Tab) Table 6-3  and Input Panels ([TK-78K0R/KE3L I/Os] and [TK-

78K0/KC2L I/Os] Tabs).) 
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Input panel Property settings of [Analog input (illuminance)] panel   
 

 TK-78K0R/KE3L and TK-78K0/KC2L 
 

Figure 6-16.  Property Settings Dialog Box (for the [Analog Input (Illuminance)] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (“Illuminance” is specified by default.) 

This item can be omitted. 
 

(2) Assigned Port(P): 

Fixed to the port assigned to the device (and cannot be changed). 
 

(3) Selecting the type 

Select either type by using the option buttons, and then specify the required values (not specified by default). 
 

(a) Compare mode(C): Value: 

If the A/D converted values are at least these specified values, output is enabled. 

However, if the “In Range” checkbox is selected, output is enabled if A/D converted values are in the range 

of the specified values. 

If multiple values are specified, the panel is stretched vertically (up to 10 stages) according to the specified 

values and the output of each specified value is passed to the processing block. 

Up to 10 values in the range from 0 to 255 can be specified.  (Values outside the range and identical 

values are ignored.) 
 

(b) Bit mode(B): Number of Bits: 

Each bit of the A/D converted values is enabled and output if the number of output bits is 1.  The panel is 

stretched vertically (up to 8 stages) according to the specified number of output bits and the output of each 

bit is passed to the processing block. 

From the drop-down list, select how many of the higher bits (1 to 8) to output. 
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Output panelProperty settings of [Digital output] panel   

 

 All products 

 

Figure 6-17.  Property Settings Dialog Box (for the [Digital Output] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 

 

(2) Assigned Port(P): 

Select the port to assign as the output pin from the drop-down list. 

Make sure not to select a port that was already assigned by specifying the properties of another panel. 

 

(3) Active Level(L): 

Select H (high) or L (low) as the active level from the drop-down list.  (H is selected by default.) 
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Output panelProperty settings of [Simple PWM] panel   
 

 All products 
 

Figure 6-18.  Property Settings Dialog Box (for the [Simple PWM] Panel) 

 
 

(1) Name(N): 

Specify the name to display on the panel (second stage).  (The name is not specified by default.) 

This item can be omitted. 
 

(2) Assigned Port(P): 

Select the port to assign as the output pin from the drop-down list. 

Make sure not to select a port that was already assigned by specifying the properties of another panel. 
 

(3) Active Level(L): 

The active level is fixed to “H”. 
 

(4) Output 

Use the option buttons to select 3 stages or 5 stages for the duty factor.  (The number of stages is not specified 

by default.) 

By selecting either setting, the panel is stretched vertically (3 or 5 stages) and a pulse is output by enabling the 

input for each duty factor.  The frequency is fixed and cannot be specified. 
 

[Remark] The output signals are shown below. 

 

Fixed to 10 ms 

0%

Input

100%

75%

50% 

25%
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Output panelProperty settings of [PWM output] panel   

 

 μPD78F92xx (from among the 78K0S/Kx1+ products), 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L,  

TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-19.  Property Settings Dialog Box (for the [PWM Output] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

The output pin is fixed to the following pins according to the device (and cannot be changed). 

 

Device or Board Name Pin 

78K0S/KB1+, 78K0S/KA1+ P42/TOH1 

78K0S/KY1+, 78K0S/KU1+ P20/TOH1 

78K0/Kx2, 78K0/KC2-L, TK-78K0/KC2L P16/TOH1/INTP5 or P15/TOH0 

78K0R/KE3-L, TK-78K0R/KE3L P11/TI03/TO03, P13/TI05/TO05, or P52/RTC1HZ/SLTI/SLTO 

 

(3) Frequency(F): 

Specify the frequency to use in the range from 80 to 81,920 Hz.  (The frequency is not specified by default.) 

 

(4) Duty(R): 

Specify the duty factor for performing PWM (pulse width modulation) using timer output.  (The duty factor is not 

specified by default.) 

Up to 15 duty factors can be specified in the range from 0 to 100%.  (Values outside the range and identical 

values are ignored.)  By specifying multiple values, the panel is stretched vertically (up to 15 stages) and a 

PWM signal is output at the specified duty factor by enabling the input for each duty factor. 

However, output is disabled if multiple inputs are enabled at the same time. 
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Output panelProperty settings of [UART6 output] panel   

 

 78K0S/KB1+, 78K0S/KA1+, 78K0/Kx2, 78K0/KC2-L, and TK-78K0/KC2L 

 

Figure 6-20.  Property Settings Dialog Box (for the [UART6 Output] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

The TxD6 pin is fixed as the output pin (and cannot be changed). 

 

[Remark] Check the communication parameters in the UART6 Settings dialog box. 
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Output panelProperty settings of [UART0 output] panel   

 

 78K0/Kx2, 78K0R/KE3-L, and TK-78K0R/KE3L 

 

Figure 6-21.  Property Settings Dialog Box (for the [UART0 Output] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

The TxD0 pin is fixed as the output pin (and cannot be changed). 

 

[Remark] Check the communication parameters in the UART0 Settings dialog box. 

 

User’s Manual  U17656EJ6V0UM 95



CHAPTER  6   WINDOW  REFERENCE 

Output panelProperty settings of [UART1 output] panel   

 

 78K0R/KE3-L and TK-78K0R/KE3L 

 

Figure 6-22.  Property Settings Dialog Box (for the [UART1 Output] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

The TxD1 pin is fixed as the output pin (and cannot be changed). 

 

[Remark] Check the communication parameters in the UART1 Settings dialog box. 
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Output panelProperty settings of [Step motor] panel   

 

 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-23.  Property Settings Dialog Box (for the [Step Motor] Panel) 

 
 

(1) Assigned Port(P): 

Select the port to assign as the output pin from the drop-down list for the 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-

L, TK-78K0R/KE3L, or TK-78K0/KC2L. 

 

(2) Speed(S): 

Select the rotation speed of the motor from the drop-down list.  (The rotation speed is not specified by default.) 

Select the rotation speed from 20, 50, 100, 200, 500, 1,000, 10,000, and 30,000 ms/step, or specify any value 

in the range from 20 to 30,000 ms/step. 

 

(3) Drive Mode(M): 

Select the motor excitation method from the drop-down list.  (The method is not specified by default.) 

The excitation method can be selected from three methods.  The output of each method is shown below.  

(Motor control is fixed to four-stage output.) 

• 1 phase excitation 

• 1-2 phase excitation 

• 2 phase excitation 

 

[Remark] The specifiable excitation method differs for the 78K0S/Kx1+.  For details, see Property settings of 

[Stepping motor] panel. 
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(a) 1 phase excitation 

 
 

Enable signal

[Forward rotation (Dir signal: H)] [Reverse rotation (Dir signal: L)] 

φ1

φ2

φ1

φ2 

Enable signal

φ1

φ2

φ1

φ2

Value specified for “Speed” [ms]  
 

[Remark] Enable signal: Signal input to the top stage after the panel is assigned 

 Dir signal:  Signal input to the second highest stage after the panel is assigned 

 

(b) 1-2 phase excitation 

 
 

Enable signal

[Forward rotation (Dir signal: H)] [Reverse rotation (Dir signal: L)] 

φ1

φ2

φ1

φ2 

Enable signal

φ1

φ2

φ1

φ2

Value specified for “Speed” [ms]  
 

[Remark] Enable signal: Signal input to the top stage after the panel is assigned 

 Dir signal:  Signal input to the second highest stage after the panel is assigned 
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(c) 2 phase excitation 

 
 

Enable signal

[Forward rotation (Dir signal: H)] [Reverse rotation (Dir signal: L)] 

φ1

φ2

φ1

φ2 

Enable signal

φ1

φ2

φ1

φ2

Value specified for “Speed” [ms]  
 

[Remark] Enable signal: Signal input to the top stage after the panel is assigned 

 Dir signal:  Signal input to the second highest stage after the panel is assigned 
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Output panelProperty settings of [Musical-scale output] panel   

 

 μPD78F0534 to 78F0537 (from among the 78K0/KE2 products), 78K0/KF2, 78K0R/KE3-L, and  

TK-78K0R/KE3L 

 

Figure 6-24.  Property Settings Dialog Box (for the [Musical-Scale Output] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Port(P): 

Fixed to the P06/TI011/TO01 pin for the 78K0/KE2 and 78K0/KF2 (and cannot be changed). 

Select the output pin from the drop-down list for the 78K0R/KE3-L and TK-78K0R/KE3L. 

 

(3) Scale(C): 

Specify the musical range of the output.  Select the lowest and highest pitches from the drop-down list. 
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Output panelProperty settings of [Buzzer] panel   

 

 78K0/Kx2, 78K0/KC2-L, and TK-78K0/KC2L 

 

Figure 6-25.  Property Settings Dialog Box (for the [Buzzer] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

Fixed to the port assigned to the device (the TOH0 or TOH1 pin) (and cannot be changed). 

 

(3) Frequency(F): 

Specify the output frequency by selecting the checkboxes.  (The frequency is not specified by default.) 

By specifying multiple frequencies, the panel is stretched vertically (up to 3 stages), input is enabled for each 

output frequency, and square waves of the specified frequencies are output. 

However, the output frequency is undefined if multiple inputs are enabled at the same time. 
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Output panelProperty settings of [7-segment display] panel   

 

 78K0/KE2, 78K0/KF2, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-26.  Property Settings Dialog Box (for the [7-Segment Display] Panel) 

 
 

(1) Name(N): 

This item cannot be specified. 

 

(2) Assigned Port(P): 

The output pin is fixed to the following pins according to the device (and cannot be changed). 

 

Device or Board Name Pin 

78K0/KE2, 78K0/KF2 P06, P05, P17, P16, P12, P11, P10, P25 to P22 

TK-78K0R/KE3L, TK-78K0/KC2L P00, P01, P20 to P27 

 

(3) Type(T): 

Select the display type of the 7-segment LED from the drop-down list.  (This type is not specified by default.) 

 

(a) DIGIT 

The character specified in Property settings of [7-segment LED jumper (digit type)] panel is displayed 

when input is enabled. 

 

(b) SEGMENT 

All segments specified in Property settings of [7-segment LED jumper (segment type)] panel are lit.  

 

(c) BIT 

Binary data is created and its numeral is displayed by assuming the bit position specified in Property 

settings of [7-segment LED jumper (bit type)] panel to be 1 when input is enabled. 
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[Caution] 7-segment LEDs of different display types cannot be used at the same time. 

 Therefore, if the display type is changed during editing, the [7-segment LED jumper] panels 

already assigned to the editing area (   ) are displayed as by default and the properties 

must be respecified. 

 

[Remark] When installing a 7-segment LED in the 78K0/KE2 or 78K0/KF2, connect the 7-segment LED in 

accordance with APPENDIX C  EXAMPLE OF THE 7-SEGMENT LED CONNECTION CIRCUIT IN THE 

78K0/KE2 AND 78K0/KF2. 
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Processing panel Property settings of [Jumper] panel   

 

 All products 

 

Figure 6-27.  Property Settings Dialog Box (for the [Jumper] Panel) 

 
 

(1) Connection ID: 

Specify the jumper identification number in the range from 1 to 99.  (This number is not specified by default.) 

Transmit enable or disable information from the jumper input to the jumper output that has the same 

identification number. 

 

[Caution] Multiple instances of the same jumper output that have the same identification number can 

be specified.  However, multiple instances of the same jumper input that have the same 

identification number cannot be specified. 
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Processing panel Property settings of [Comparator] panel   

 

 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-28.  Property Settings Dialog Box (for the [Comparator] Panel) 

 
 

(1) Compare bits: 

Select the number of bits to compare (4 or 8 bits) from the drop-down list.  (“4bit” is selected by default.) 
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Processing panel Property settings of [UART6 jumper output] panel   

 

 78K0S/KB1+, 78K0S/KA1+, and 78K0/Kx2 

 

Figure 6-29.  Property Settings Dialog Box (for the [UART6 Jumper Output] Panel) 

 
 

[Caution] This panel is provided to secure compatibility with Applilet EZ PL V3.6 or earlier.  It is used with 

the [UART6 output] output panel. 

 

(1) Bit Number: 

Specify the bit position that is the identification number of the jumper in the range from 0 to 7.  (This bit position 

is not specified by default.) 

If input is enabled, 1 is transmitted to the bit position of the [UART6 output] panel in the output block area, and, 

if input is disabled, 0 is transmitted to the bit position. 
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Processing panel Property settings of [UART0 jumper output] panel   

 

 78K0/Kx2 

 

Figure 6-30.  Property Settings Dialog Box (for the [UART0 Jumper Output] Panel) 

 
 

[Caution] This panel is provided to secure compatibility with Applilet EZ PL V3.6 or earlier.  It is used with 

the [UART0 output] output panel. 

 

(1) Bit Number: 

Specify the bit position that is the identification number of the jumper in the range from 0 to 7.  (This bit position 

is not specified by default.) 

If input is enabled, 1 is transmitted to the bit position of the [UART0 output] panel in the output block area, and, 

if input is disabled, 0 is transmitted to the bit position. 
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Processing panel Property settings of [7-segment LED jumper (digit type)] panel   

 

 78K0/KE2, 78K0/KF2, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-31.  Property Settings Dialog Box (for the [7-Segment LED Jumper (Digit Type)] Panel) 

 
 

[Caution] The type of 7-segment LED to use must be prespecified in Property settings of [7-segment 

display] panel. 

 

(1) Column: 

Specify the digits to display for the 7-segment LED when the input to this jumper is enabled.  (These digits are 

not specified by default.) 

If multiple panels that have the same number specified for a digit, make sure that the panels are not enabled at 

the same time. 

 

(2) Number(N): 

Select the character to display for the 7-segment LED (0 to 9 or A to F) from the drop-down list when the input 

is enabled.  (This character is not specified by default.) 

 

[Remark] When installing a 7-segment LED in the 78K0/KE2 or 78K0/KF2, connect the 7-segment LED in 

accordance with APPENDIX C  EXAMPLE OF THE 7-SEGMENT LED CONNECTION CIRCUIT IN THE 

78K0/KE2 AND 78K0/KF2. 
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Processing panel Property settings of [7-segment LED jumper (segment type)] panel   

 

 78K0/KE2, 78K0/KF2, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-32.  Property Settings Dialog Box (for the [7-Segment LED Jumper (Segment Type)] Panel) 

 
 

[Caution] The type of 7-segment LED to use must be prespecified in Property settings of [7-segment 

display] panel. 

 

(1) Column: 

Specify the digits to display for the 7-segment LED when the input to this jumper is enabled.  (These digits are 

not specified by default.) 

 

(2) Segments: 

Specify the segments (a to g or p) of the 7-segment LED to light when input is enabled.  (These segments are 

not specified by default.) 

Multiple checkboxes can be selected. 

 

[Remark] When installing a 7-segment LED in the 78K0/KE2 or 78K0/KF2, connect the 7-segment LED in 

accordance with APPENDIX C  EXAMPLE OF THE 7-SEGMENT LED CONNECTION CIRCUIT IN THE 

78K0/KE2 AND 78K0/KF2. 
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Processing panel Property settings of [7-segment LED jumper (bit type)] panel   

 

 78K0/KE2, 78K0/KF2, TK-78K0R/KE3L, and TK-78K0/KC2L 

 

Figure 6-33.  Property Settings Dialog Box (for the [7-Segment LED Jumper (Bit Type)] Panel) 

 
 

[Caution] The type of 7-segment LED to use must be prespecified in Property settings of [7-segment 

display] panel. 

 

(1) Bit Number: 

Specify the bit position of the binary data of the numerical value to display for the 7-segment LED in the range 

from 0 to 7 when input to this jumper is enabled.  (This bit position is not specified by default.) 

 

[Remark] When installing a 7-segment LED in the 78K0/KE2 or 78K0/KF2, connect the 7-segment LED in 

accordance with APPENDIX C  EXAMPLE OF THE 7-SEGMENT LED CONNECTION CIRCUIT IN THE 

78K0/KE2 AND 78K0/KF2. 
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Processing panel Property settings of [Flip-flop] panel   

 

 All products 
 

Figure 6-34.  Property Settings Dialog Box (for the [Flip-Flop] Panel) 

 
 

(1) Type(T): 

Select the operation type of the flip-flop (RS-FF, D-FF, T-FF, or JK-FF) from the drop-down list.  (This type is not 

specified by default.) 

The truth table for each operation type is shown below. 
 

Table 6-10.  Truth Values for Each Flip-Flop Operation 

RS-FF D-FF  

S R Q Q D C Q Q  

0 0 Retain Retain 0 ↑ 0 1  

0 1 0 1 1 ↑ 1 0  

1 0 1 0 X 0 Retain Retain  

1 1 0[Note] [Note]0 X 1 Retain Retain  

    X ↓ Retain Retain  

         

T-FF JK-FF 

T R Q Q J K CK Q Q 

0 1 Retain Retain 0 0 X Retain Retain 

↑ 1 Invert Invert 0 1 X Retain Retain 

1 1 Retain Retain 1 0 X Retain Retain 

↓ 1 Retain Retain 1 1 X Retain Retain 

x 0 0 1 0 0 ↑ Retain Retain 

    0 1 ↑ 0 1 

    1 0 ↑ 1 0 

    1 1 ↑ Invert Invert 

0 = Off, 1 = On, ↑: Change from off to on, ↓: Change from on to off, X = Not specified 
 

[Note] Generally, input is disabled (and output is undefined), but output is disabled with a reset prioritized in 

Applilet EZ PL. 
 

(2) Initial value(I): 

Specify 0 or 1 as the initial value during operation. 

If the operation type is not specified, the initial value is not specified.  0 is specified every time the operation 

type is specified. 
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Processing panel Property settings of [Counter] panel   

 

 All products 

 

Figure 6-35.  Property Settings Dialog Box (for the [Counter] Panel) 

 
 

(1) Type(T): 

Select the operation type of the counter from the drop-down list.  (This type is not specified by default.) 

 

(a) HOLD 

The counter is incremented every time the clock input is disabled.  If the count value matches the value 

specified in the properties, the output is enabled.  The counter stops at the maximum count value. 

 

(b) CYCLIC 

The counter is incremented every time the clock input is disabled.  If the count value matches the value 

specified in the properties, the output is enabled.  The counter is reset (0) at the maximum count value 

when a signal is input. 

 

(2) Count Value(V): 

Specify the value by which output is enabled.  (This value is not specified by default.) 

Up to 15 values in the range from 0 to 32,767 can be specified.  (Values outside the range and identical values 

are ignored.)  By specifying multiple values, the panel is stretched vertically (up to 15 stages) and multiple 

outputs can be processed. 

The initial value of the counter is 0.  Input from a higher block is assumed to be a reset signal and that resets 

the counter to the initial value. 
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Processing panel Property settings of [Binary counter] panel   

 

 All products 

 

Figure 6-36.  Property Settings Dialog Box (for the [Binary Counter] Panel) 

 
 

(1) Type(T): 

Select the operation type of the binary counter from the drop-down list.  (This type is not specified by default.) 

 

(a) BCD mode 

The counter is incremented from 0 to 9 and the counter returns to 0 after being incremented to 9. 

 

(b) HEX mode 

The counter is incremented from 0 to 15 (F in hexadecimal) and the counter returns to 0 after being 

incremented to F. 

 

The truth table for the binary counter is shown below. 

 

Table 6-11.  Truth Values for Binary Counter Operations 

Binary Counter 

CP0 CP1 MR Output 

↑ 1 0 Increment 

↓ 0 0 Increment 

↓ X 0 Retain 

↑ X 0 Retain 

↑ 0 0 Retain 

↓ 1 0 Retain 

X X 1 O0 = O1 = O2 = O3 = 0 

0 = Off, 1 = On, ↑: Change from off to on, ↓: Change from on to off, X = Not specified 
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Processing panel Property settings of [Timer] panel   
 

 All products 
 

Figure 6-37.  Property Settings Dialog Box (for the [Timer] Panel) 

 
 

(1) Type(T): 

Select the operation type of the timer from the drop-down list.  (This type is not specified by default.) 
 

(a) HOLD 

The output is enabled when the specified time elapses after the input is enabled. 

The input remains enabled after the output is enabled. 
 

(b) TOGGLE 

The output is enabled when the specified time elapses after the input is enabled. 

The input is alternately enabled and disabled in the specified time cycle after the output is enabled. 
 

(c) ONE-SHOT 

The output is enabled when the input is enabled and disabled when the specified time elapses. 

A change in the input information does not affect the period during which the output is enabled. 
 

(d) ONE-SHOT (RETRIGGERABLE) 

The output is enabled when the input is enabled and disabled when the specified time elapses. 

The timer restarts if the input is enabled again while the output is enabled. 
 

(2) Time Setting(S): 

Specify the time of timer operations in the following dialog box, which is opened by clicking [Set…]. 
 

 
 

(a) Time(T): 

Up to 8 hours 59 minutes and 59 seconds can be specified in 0.05 second units if the specified time is less 

than 20 minutes or in 1 second units if the specified time is at least 20 minutes.  (This time is not specified 

by default.) 

For input in 0.01 second units, the time is rounded to the nearest value in 0.05 second units after input. 
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Processing panel Property settings of [Delay] panel   

 

 All products 

 

Figure 6-38.  Property Settings Dialog Box (for the [Delay] Panel) 

 
 

(1) Time(T): 

When the time specified in the properties elapses after the input signal changes, the same signal as that 

previously input is output. 

Up to 8 hours 59 minutes and 59 seconds can be specified in 0.05 second units if the specified time is less 

than 20 minutes or in 1 second units if the specified time is at least 20 minutes.  (This time is not specified by 

default.) 

For input in 0.01 second units, the time is rounded to the nearest value in 0.05 second units after input. 

If the input signal changes before a signal is output, the time is measured again from that point.  Therefore, if 

the input signal is inverted within the specified time, the output signal does not change. 
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Processing panel Property settings of [Clock] panel   

 

 All products 

 

Figure 6-39.  Property Settings Dialog Box (for the [Clock] Panel) 

 
 

(1) Pulse Width(P): 

A width from 0.01 seconds to 8 hours 59 minutes and 59 seconds can be specified in 0.01 second units if the 

specified time is less than 5 minutes, in 0.05 second units if the specified time is less than 20 minutes, or in 1 

second units if the specified time is at least 20 minutes.  (This width is not specified by default.) 
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Processing panel Property settings of [Stepping motor] panel   

 

 78K0S/Kx1+ 

 

Figure 6-40.  Property Settings Dialog Box (for the [Stepping Motor] Panel) 

 
 

(1) Speed(S): 

Select the rotation speed of the motor from the drop-down list.  (The rotation speed is not specified by default.) 

Select the rotation speed from 10, 20, 30, 40, 50, and 100 ms/step. 

 

(2) Drive mode(M): 

Select the motor excitation method from the drop-down list.  (The method is not specified by default.) 

The excitation method can be selected from two methods.  The output of each method is shown below.  (Motor 

control is fixed to four-stage output.) 

• 1 phase excitation 

• 2 phase excitation 

 

[Remark] The specifiable excitation method differs for the 78K0/Kx2, 78K0R/KE3-L, 78K0/KC2-L, TK-

78K0R/KE3L, and TK-78K0/KC2L.  For details, see Property settings of [Step motor] panel. 

 

User’s Manual  U17656EJ6V0UM 117



CHAPTER  6   WINDOW  REFERENCE 

(a) 1 phase excitation 

 
 

ENB 
(e signal) 

[Forward rotation (dir signal: H)] [Reverse rotation (dir signal: L)] 

φ1

φ2

φ1

φ2 

ENB 
(e signal)

φ1

φ2

φ1

φ2

Value specified for “Speed” [ms]  
 

[Remark] e signal: Signal input from above after the panel is assigned 

 dir signal: Signal input from the left after the panel is assigned 

 

(b) 2 phase excitation 

 
 

φ1 

φ2

φ1 

φ2

φ1

φ2

φ1

φ2

ENB 
(e signal) 

[Forward rotation (dir signal: H)] [Reverse rotation (dir signal: L)] 

ENB 
(e signal)

Value specified for “Speed” [ms]  
 

[Remark] e signal:  Signal input from above after the panel is assigned 

 dir signal:  Signal input from the left after the panel is assigned 
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Processing panel Property settings of [Reset] panel   

 

 All products 

 

Figure 6-41.  Property Settings Dialog Box (for the [Reset] Panel) 

 
 

(1) Input(I): 

Select 0 or 1.  (This value is not specified by default.) 
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Port Setting dialog box 
 

This dialog box displays the I/O ports that are currently specified in the properties. 

This dialog box is opened by selecting the [View] menu and then [Assigned ports]. 

 

Figure 6-42.  Port Setting Dialog Box 

 
 

The following items are described below: 

 Columns in the Port Setting dialog box

 Function buttons
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Columns in the Port Setting dialog box 
The meanings of the columns are as follows. 

 

Item Meaning 

assigned The ports of the selected device or board are listed in this column. 

Mode The I/O modes of the ports are displayed in this column.  (The default is “Input”.) 

The mode can be switched between “Input” and “Output” by double-clicking it. 

The mode cannot be changed if “InputFix” or “OutputFix” is displayed. 

Output If the mode is “Output” or “OutputFix”, the output value is displayed.  (This value is “0” by default.) 

The value can be switched between “0” and “1” by double-clicking it. 

Pullup resistor Whether an on-chip pull-up resistor is used is displayed in this column.  (The default is “Unused”.) 

The status can be switched between “Used” and “Unused” by double-clicking it. 

Assigned Panel The name of a panel is indicated in this column. 

location IN or OUT:  Indicates an input or output panel. 

01, 02, 03, …: Separately indicates the position of the panel for the input block and output block areas 

 by using a block number, assuming the upper block to be 1. 

 

Function buttons 
 

Button Function 

Applies the settings and closes the Port Setting dialog box. 
 

Does not apply the settings and closes the Port Setting dialog box. 
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Target CPU Settings dialog box 
 

Specify the device or board to use in this dialog box. 

This dialog box is opened by selecting the [Settings] menu and then [Target CPU]. 

 

Figure 6-43.  Target CPU Settings Dialog Box 

 
 

The following items are described below: 

 Items in the Target CPU Settings dialog box

 Function buttons

 

Items in the Target CPU Settings dialog box 
 

(1) Target(T): 

Specify the device or board to use. 

 

(2) Device(D): 

Specify the device to use after specifying the target. 

 

(3) System Clock(C): 

Specify the source of the clock to supply to the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 78K0/KC2-L. 

• Internal Oscillator 

 Specify this if using the internal high-speed oscillator in the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-L, or 

78K0/KC2-L. 
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• External Clock 

 Specify this if using an external clock. 

• Crystal/Ceramic Clock 

 Specify this if using a clock source other than the previous two sources. 

 

(4) Frequency (MHz)(F): 

Oscillation frequency of the target to use 

 

(5) CPU Clock(M), Peripheral: 

Specify the CPU clock and peripheral clock to use. 

 

[Caution] The items that can be specified for the system clock source and the values that can be entered 

for the frequency differ depending on the device or board.  For details, see the user’s manual for 

each device or board. 

 

Function buttons 
 

Button Function 

Applies the settings and closes the Target CPU Settings dialog box. 
 

Does not apply the settings and closes the Target CPU Settings dialog box. 
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Watchdog Timer Setting dialog box 
 

Specify the use of the watchdog timer and its settings in this dialog box. 

This dialog box is opened by selecting the [Settings] menu, [CPU Function], and then [Watchdog timer]. 

 

Figure 6-44.  Watchdog Timer Setting Dialog Box 

 
 

The following items are described below: 

 Items in the Watchdog Timer Setting dialog box

 Function buttons

 

Items in the Watchdog Timer Setting dialog box 
 

(1) Watchdog timer is used 

Select this checkbox if using the watchdog timer. 

 

(2) Clock source(C): 

This item can be selected if the checkbox in (1) is selected. 

Select the internal low-speed oscillation clock (fRL) or main system clock (Fx) for the 78K0S/Kx1+. 

This item is fixed to the internal low-speed oscillation clock (fRL) for other devices (and cannot be changed). 

 

(3) Overflow time(T): 

This item can be selected if the checkbox in (1) and the clock in (2) are selected. 

Select the overflow time from the drop-down list. 

 

Function buttons 
 

Button Function 

Applies the settings and closes the Watchdog Timer Setting dialog box. 
 

Does not apply the settings and closes the Watchdog Timer Setting dialog box. 
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UART0 Settings dialog box 
 

Specify the UART0 I/O properties in this dialog box. 

This dialog box is opened by selecting the [Settings] menu, [CPU Function], and then [UART0]. 

 

Figure 6-45.  UART0 Settings Dialog Box 

 
 

The following items are described below: 

 Items in the UART0 Settings dialog box

 Function buttons

 

Items in the UART0 Settings dialog box 
 

(1) Speed(S): 

Select the UART0 communication speed from the drop-down list. 

The values that can be selected depend on the target CPU and specified peripheral clock. 

 

(2) Data bits(B): 

Select the number of UART0 data bits from the drop-down list. 

5 bits (only for 78K0R/KE3-L and TK-78K0R/KE3L), 7 bits, or 8 bits can be selected. 

The selected number of bits is reflected in the number of stages of UART0 output panels assigned to the 

output block area. 

 

(3) Parity(P): 

Select the UART0 parity setting from the drop-down list. 

No parity, 0 parity output, odd parity output, or even parity output can be selected. 

 

(4) Stop Bits(T): 

Select the number of UART0 stop bits from the drop-down list. 

1 bit or 2 bits can be selected. 
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(5) Start Bit(S): 

Select the UART0 start bit from the drop-down list. 

The start bit is fixed to LSB for the 78K0/Kx2. 

MSB or LSB can be selected for other devices. 

 

Function buttons 
 

Button Function 

Applies the settings and closes the UART0 Settings dialog box. 
 

Does not apply the settings and closes the UART0 Settings dialog box. 
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UART1 Settings dialog box 
 

Specify the UART1 I/O properties in this dialog box. 

This dialog box is opened by selecting the [Settings] menu, [CPU Function], and then [UART1]. 

 

Figure 6-46.  UART1 Settings Dialog Box 

 
 

The following items are described below: 

 Items in the UART1 Settings dialog box

 Function buttons

 

Items in the UART1 Settings dialog box 
 

(1) Speed(S): 

Select the UART1 communication speed from the drop-down list. 

The values that can be selected depend on the specified peripheral clock. 

 

(2) Data bits(B): 

Select the number of UART1 data bits from the drop-down list. 

5 bits, 7 bits, or 8 bits can be selected. 

The selected number of bits is reflected in the number of stages of UART1 output panels assigned to the 

output block area. 

 

(3) Parity(P): 

Select the UART1 parity setting from the drop-down list. 

No parity, 0 parity output, odd parity output, or even parity output can be selected. 

 

(4) Stop Bits(T): 

Select the number of UART1 stop bits from the drop-down list. 

1 bit or 2 bits can be selected. 

 

(5) Start Bit(S): 

Select the UART1 start bit from the drop-down list. 

MSB or LSB can be selected. 
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Function buttons 
 

Button Function 

Applies the settings and closes the UART1 Settings dialog box. 
 

Does not apply the settings and closes the UART1 Settings dialog box. 
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UART6 Settings dialog box 
 

Specify the UART6 I/O properties in this dialog box. 

This dialog box is opened by selecting the [Settings] menu, [CPU Function], and then [UART6]. 

 

Figure 6-47.  UART6 Settings Dialog Box 

 
 

The following items are described below: 

 Items in the UART6 Settings dialog box

 Function buttons

 

Items in the UART6 Settings dialog box 
 

(1) Speed(S): 

Select the UART6 communication speed from the drop-down list. 

The values that can be selected depend on the target CPU and specified peripheral clock. 

 

(2) Data bits(B): 

Select the number of UART6 data bits from the drop-down list. 

7 bits or 8 bits can be selected. 

The selected number of bits is reflected in the number of stages of UART6 output panels assigned to the 

output block area. 

 

(3) Parity(P): 

Select the UART6 parity setting from the drop-down list. 

No parity, 0 parity output, odd parity output, or even parity output can be selected. 

 

(4) Stop Bits(T): 

Select the number of UART6 stop bits from the drop-down list. 

1 bit or 2 bits can be selected. 

 

(5) Start Bit(S): 

Select the UART6 start bit from the drop-down list. 

MSB or LSB can be selected. 
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Function buttons 
 

Button Function 

Applies the settings and closes the UART6 Settings dialog box. 
 

Does not apply the settings and closes the UART6 Settings dialog box. 
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Flash Memory Programmer Settings dialog box 
 

In this dialog box, specify the settings when writing to the flash memory provided on the device or board by using 

Applilet EZ PL.  The items displayed in this dialog box differ depending on the device or board selected in the Target 

CPU Settings dialog box.  Specify the settings according to the description below. 

This dialog box is opened by selecting the [Settings] menu and then [FLASH memory programmer]. 

 

• If a device is selected in the Target CPU Settings dialog box 

 

Figure 6-48.  Flash Memory Programmer Settings Dialog Box (for a Device) 

 
 

The following items are described below: 

 Items in the Flash Memory Programmer Settings dialog box (for a device)

 Function buttons (common)) (see next page) 

 

Items in the Flash Memory Programmer Settings dialog box (for a device) 
 

(1) Write execution file(T): 

Specify the file name of the flash memory programmer to add, including the full file path. 

 

(2) Command Options(O): 

Specify startup parameters as required. 
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• If an evaluation board [Note] is selected in the Target CPU Settings dialog box 

 

Figure 6-49.  Flash Memory Programmer Settings Dialog Box (for an Evaluation Board [Note]) 

 
 

The following items are described below: 

 Items in the Flash Memory Programmer Settings dialog box (for an evaluation board [Note])

 Function buttons (common)

 

Items in the Flash Memory Programmer Settings dialog box (for an evaluation board [Note]) 
 

(1) COM port(P): 

Select the COM port to use for writing to the flash memory from the drop-down list.  (“Autoselect” is specified 

by default [Note].) 

 

(2) Wait 

If there is no problem in writing to the flash memory, use the default value “2”.  If data cannot be written to the 

flash memory, or if a communication error has occurred, select a greater value from the drop-down list. 

 

Function buttons (common) 
 

Button Function 

Applies the settings and closes the Flash Memory Programmer Settings dialog box. 
 

Does not apply the settings and closes the Flash Memory Programmer Settings dialog box. 
 

 

[Note] Automatic detection cannot be used for some evaluation boards.  See 3.2.2 Setting up Applilet EZ PL for 

details. 
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Saved Data Folder dialog box 
 

Specify where to save data in this dialog box. 

This dialog box is opened by selecting the [Settings] menu and then [Folders]. 

 

Figure 6-50.  Saved Data Folder Dialog Box 

 
 

The following items are described below: 

 Items in the Saved Data Folder dialog box

 Function buttons

 

Items in the Saved Data Folder dialog box 
 

(1) Project Folder(P) 

“C:…\My Documents\Applilet EZ PL\Project” is specified by default.  (The location of the My Documents folder 

differs depending on the PC environment and settings.) 

A desired location can also be specified. 

 

(2) Location 

“C:…\My Documents\Applilet EZ PL\Save” is specified by default.  (The location of the My Documents folder 

differs depending on the PC environment and settings.) 

A desired location can also be specified. 

 

[Caution] If a version of Applilet EZ PL earlier than Ver.2.x is installed, project and location files are saved 

to the following folders by default. 

  Project files: C:\Program Files\Applilet EZ PL\Project 

  Location files: C:\Program Files\Applilet EZ PL\Save 

 If a version of Applilet EZ PL earlier than Ver.2.x is installed to a folder other than the default, 

project and location files are saved in the My Documents folder.  In this case, manually change 

the folder. 
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Function buttons 
 

Button Function 

Applies the settings and closes the Saved Data Folder dialog box. 
 

Does not apply the settings and closes the Saved Data Folder dialog box. 
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CHAPTER 7 ERROR MESSAGES 
 

 

7.1 When Editing a Panel 
 

The meanings of the error messages displayed when editing a panel are described below. 

 

Figure 7-1.  Example of an Error Message Displayed When Editing a Panel 

 
 

“Unable to change size.” 

This message is displayed if a panel cannot be vertically stretched by specifying or changing the properties due 

to the presence of other panels. 

Make sure to secure the required number of vacant blocks before specifying or changing the properties. 

 

“The range for generating an object has been exceeded.  Reduce the number of panels.” 

This message is displayed if the number of assigned processing panels exceeds the maximum value for 

generating object code. 

Assign panels so that the ROM size does not exceed the size of the flash ROM provided in the product.  (Watch 

the  when assigning panels [Note].) Status bar

 

[Note] The estimated ROM size differs from the result of actual compilation. 

 

7.2 When Compiling or Writing to Flash Memory 
 

The meanings of and countermeasures for the error messages displayed when object code (*.hex) is automatically 

generated or data is written to the flash memory by selecting the [Run] menu and then [Build & Write] are described 

below. 

 

Figure 7-2.  Example of an Error Message Displayed When Compiling or Writing to Flash Memory 
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“The compilation stopped.” 

This message is displayed if compilation stops due to the detection of an error during compilation. 

 

“The same port is assigned to multiple I/O panels.  port=xxxxx” 

This message is displayed if the same port is specified in the property settings of multiple I/O panels. 

Check for ports that have been specified more than once in the Port Setting dialog box. 

(xxxxx: Name of a port that has been specified more than once) 

 

“The properties of nnnnn (zzzz) are not specified.” 

This message is displayed if the properties of an I/O panel for which the properties must be specified are not 

specified. 

(nnnnn: Panel name, zzzz: Name specified in the properties) 

[Countermeasure] 

Check for panels marked by a  mark in the editing area.  (The  mark indicates that the properties are not 

specified.) 

Make sure that there are no panels whose properties are not specified. 

 

“The properties of nnnnn (x, y) are not specified.” 

This message is displayed if the properties of an I/O panel for which the properties must be specified are not 

specified. 

(nnnnn: Panel name, x, y: Block coordinates, taking the upper left corner of the processing block area as (1, 1)) 

Check for panels marked by a  mark in the editing area.  (The  mark indicates that the properties are not 

specified.) 

Make sure that there are no panels whose properties are not specified. 

 

“There is no connection adjacent to nnnnn (zzzz).” 

This message is displayed if a panel is disconnected. 

(nnnnn: Panel name, zzzz: Name specified in the properties) 

[Countermeasure] 

Assigned panels must be wired.  Check for panels not connected to other panels, and then execute compilation.  

(Delete panels that will not be used.) 

 

“There is no connection adjacent to nnnnn (x, y).” 

This message is displayed if a panel is disconnected. 

(nnnnn: Panel name, x, y: Block coordinates, taking the upper left corner of the processing block area as (1, 1)) 

[Countermeasure] 

Assigned panels must be wired.  Check for panels not connected to other panels, and then execute compilation.  

(Delete panels that will not be used.) 
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“The jumper that has the identification number %d is not connected.” 

This message is displayed if jumper connections are insufficient. 

[Countermeasure] 

Assigned panels must be wired.  Check for panels not connected to other panels, and then execute compilation.  

(Delete panels that will not be used.) 

 

“Running the command failed.  (Command name, error code)” 

This message is displayed if running the assembler, linker, or object converter failed during compilation. 

The ApEZPL.ini file might have been changed after installing Applilet EZ PL. 

 

“Assembling failed.” 

This message is displayed if an error is detected during assembling. 

 

“An error was detected.” 

This message is displayed if an error other than the above is detected during compilation. 

Make sure that no more than 10 counter, timer, and delay panels have been assigned in total (only for the 

78K0S/Kx1+). 

 

“The writer command is not specified.” 

This message is displayed if the command for writing to flash memory is not specified in the ApEZPL.ini file. 

The ApEZPL.ini file might have been changed after installing Applilet EZ PL. 

[Countermeasure] 

Uninstall and then reinstall Applilet EZ PL. 

 

“Execution failed.” 

This message is displayed if the flash writer was not terminated.  (Termination of flash writing could not be 

recognized.) 

Check the settings in the Flash Memory Programmer Settings dialog box and those for the evaluation board. 

 

“The flash memory will not be written.” 

This message is displayed if [Cancel] is clicked in the dialog box for confirming the execution of writing to flash 

memory. 
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CHAPTER  7   ERROR  MESSAGES 

“Writing failed.  code=xx” 

This message is displayed if writing to flash memory failed. 

Check the connections on the evaluation board and the switch settings. 

Perform the following countermeasures according to the displayed code number (xx). 

“code=0” means that the flash memory was successfully written. 

 

Code Number Countermeasure 

code=1, 2, 4, 5 This is a writer software call error. 

If this error occurs, contact NEC Electronics. 

code=3 This error is displayed, if the COM port cannot be automatically recognized or is being used by 

another application. 

Make sure that no other application is using the port used for the evaluation board. 

If this error is still displayed, see 3.2.2 Setting up Applilet EZ PL. 

code=7 to 28 This is a write error. 

Specify a greater value in the Wait field in the Flash Memory Programmer Settings dialog box.  

However, writing will be slower. 

code=33 to 40 This error is displayed if the HEX file is corrupt. 

If this error occurs, contact NEC Electronics. 

code=99 This error indicates that a time out has occurred for write processing due to an error. 

Check the connections of the power switch, flash rewrite switch, and USB cable, and then re-

execute writing.  If this error occurs again, contact NEC Electronics. 

 

“The information could not be saved.” 

This message is displayed if saving the information specified in the dialog box displayed by selecting a submenu 

item in the [Settings] menu failed. 

[Countermeasure] 

The file for saving the information might be corrupt.  Uninstall and then reinstall Applilet EZ PL. 

 

“The flash memory programmer is not specified.” 

This message is displayed if the flash memory programmer execution file is not specified. 

[Countermeasure] 

Specify the execution file by selecting the [Settings] menu and then [FLASH memory programmer]. 

 

“Running the command failed.  (code)” 

This message is displayed if the flash memory programmer could not be run. 

[Countermeasure] 

Check the specified settings by selecting the [Settings] menu and then [FLASH memory programmer] and 

specify the correct execution file. 
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APPENDIX A  AUTOMATICALLY GENERATED FILES (FOR 78K0/Kx2 AND 78K0R/KE3-L) 
 

 

A.1 File Structure 
 

Applilet EZ PL automatically generates object code (*.hex) that can be executed in the 78K0/Kx2 or 78K0R/KE3-L 

by using a compiler after it generates a C language source file (*.c or *.h) for the 78K0 or 78K0R Series based on the 

information about the assigned panels. 

The generated C language source file (*.c or *.h) is stored in the location specified as the destination folder for 

saving projects in Applilet EZ PL.  (A folder that has the name of the panel location file (without the extension) is 

automatically generated.) 

A project file of the integrated development environment platform PM+ (*.prj) is also automatically generated. 

 

Figure A-1.  Files Generated by Applilet EZ PL (for 78K0/Kx2 and 78K0R/KE3-L) 

 

  

Build 

[Generated files]

Panel location 
file 

Generated based on panel 
assignment information 

(Files that have fixed contents)

Panel library 

(PM+ project file) 

xxx.prj 

config.h 
 
… 
… 
… 

main.h panel.h 

panel.c 
 
void panel() 
{ 
        ... 
} 
 

main.c 
 
int main() 
  { 
     panel() 
  } xxx.loc 

 
INPUT 
  ... 
PROCESS 
  ... 
 

 

 

 

[Caution] The files above are overwritten if object code (*.hex) is generated by Applilet EZ PL.  Therefore, 

when referencing the generated source file, use only the file after copying the folder containing 

the file to a different location. 

 Note that NEC Electronics makes no guarantees about the contents of the files generated by 

Applilet EZ PL. 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

Applilet EZ PL generates the files below.  A library is provided for processing each panel, and Applilet EZ PL 

generates the code for calling the functions in that library. 

 

(1) Program files (*.c) 

 

Table A-1.  Generated Program Files 

File Name Overview 

common.c Code for common processing 

int.c Code for processing related to interrupts 

main.c Code for the main processing for the system 

panel.c Code for panel code 

port.c Code for processing related to port I/O 

system.c Code for processing related to the system 

systeminit.c Code for processing related to initializing the system 

timer.c Code for processing related to timers 

watchdogtimer.c Code for processing related to the watchdog timer 

 

(2) Header files (*.h) 

 

Table A-2.  Generated Header Files 

File Name Overview 

7seg.h Definitions of items related to 7-segment LED display 

74hc.h Definitions of items related to the 74 Series logic IC 

ad.h Definitions of items related to A/D converter input 

buzzer.h Definitions of items related to sounding the buzzer 

config.h Definitions of the items specified on the GUI 

counter.h Definitions of items related to counter processing 

comp.h Definitions of items related to comparator processing 

delay.h Definitions of items related to delay processing 

digitalio.h Definitions of items related to digital I/O 

flipflop.h Definitions of items related to flip-flop processing 

int.h Definitions of items related to interrupts 

key.h Definitions of items related to key input 

lcd.h Definitions of items related to LCD display 

logic.h Definitions of items related to logic processing 

net.h Definitions of items related to network processing 

panel.h Definitions of items related to the panel code (panel.c) 

port.h Definitions of items related to port I/O 

pwm.h Definitions of items related to PWM processing 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

File Name Overview 

serial.h Definitions of items related to the serial interface 

stepmotor.h Definitions of items related to the step motor 

switch.h Definitions of items related to switch input 

system.h Definitions of items related to the system 

timer.h Definitions of items related to timers 

timerpanel.h Definitions of items related to timer panels 

watchdogtimer.h Definitions of items related to the watchdog timer 

web.h Definitions of items related to WEB I/O 

 

(3) Panel library file 

A library file (EZPL78K0KZ2.LIB) for processing each panel is stored in the obj folder and is linked when object 

code is generated. 

 

(4) PM+ project file (*.prj)  

The name of a PM+ project file is “the name of the target panel location file (without the extension) + prj”. 

All of the source files and include files above are added to the generated project file as PM+ projects. 

PM+ facilitates the sequence of operations in software development, such as running the editor, builder, and 

debugger.  By loading this project file into PM+, software generated by Applilet EZ PL can be studied and 

evaluated more efficiently. 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

A.2 Interface 
 

Applilet EZ PL expands calling the processing of panels to panel.c. 

The major macros expanded to panel.c are listed below. 

For details about the macros, see the Function and macro interface.pdf file on the CD.  (See page 20 for the file 

location.) 

 

Table A-3.  Macros Expanded to panel.c 

Processing Macro Name Processing Macro Name 

DGIN_INIT0 BUZZ_INIT0 Sounding the buzzer Digital input 

DGIN_INIT BUZZ_INIT 

DGIN_PROC BUZZ_PROC 

KEY_INIT0  LCD2_INIT0 LCD display 

Digital output DGOUT_PROC LCD2_PROC 

ANI_PROC  WEBO_INIT0 Analog input Web output 

ANI_OUT WEBO_PROC 

URX6_INIT0 SEG_INIT0 UART6 input 7-segment LED output 

URX6_PROC SEG_DISP_1 

URX6_OUT SEG_DISP 

UTX6_INIT0 AND_PROC Logic UART6 output 

UTX6_PROC OR_PROC 

URX0_INIT0 XOR_PROC UART0 input 

URX0_PROC NOT_PROC 

URX0_OUT COMP_INIT0 Comparator 

UTX0_INIT0 COMP_PARAM UART0 output 

UTX0_PROC COMP_PROC 

PULSE_INIT0 COMP_INIT0 Simple PWM output Comparator 

PULSE_INIT COMP_PARAM 

PULSE_PROC COMP_PROC 

PWM_INIT0 JKFF_INIT0 Flip-flop PWM output 

PWM_INIT JKFF_INIT 

PWM_PARAM JKFF_PROC 

PWM_PROC RSFF2_INIT0 

SMOT_INIT0 RSFF2_INIT Stepping-motor output 

SMOT_INIT RSFF2_PROC 

SMOT_PROC TFF2_INIT0 

WEBI_PROC TFF2_INIT Web input 

WEBI_OUT TFF2_PROC 
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Processing Macro Name Processing Macro Name 

DFF2_INIT0 IC74HC30_PROC Flip-flop Logic IC 

DFF2_INIT IC74HC51_PROC 

DFF2_PROC IC74HC77_INIT0 

CNT_INIT0 IC74HC77_INIT Counter 

CNT_INIT IC74HC77_PROC 

CNT_PROC IC74HC112_INIT0 

CNT_OUT IC74HC112_INIT 

BCNT_INIT0 IC74HC112_PROC 

BCNT_INIT IC74HC112_PROC 

BCNT_PROC IC74HC133_PROC 

TIMER_INIT0 IC74HC138_PROC Timer 

TIMER_INIT IC74HC148_PROC 

TIMER_PROC IC74HC153_PROC 

DELAY_INIT0 IC74HC166_INIT0 Delay 

DELAY_INIT IC74HC166_INIT 

DELAY_PROC IC74HC166_PROC 

CLK_INIT0 IC74HC280_PROC Clock 

CLK_INIT IC74HC283_PROC 

CLK_PROC IC74HC4002_PROC 

IC74HC00_PROC IC74HC4072_PROC Logic IC 

IC74HC02_PROC IC74HC4075_PROC 

IC74HC10_PROC IC74HC4078_PROC 

IC74HC11_PROC IC74HC4511_INIT0 

IC74HC20_PROC IC74HC4511_INIT 

IC74HC21_PROC IC74HC4511_PROC 

IC74HC27_PROC IC74HC7266_PRC 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

A.2.1 Digital input 

 

Processing Initializes digital input. DGIN_INIT0 

Format DGIN_INIT0 (Active) 

Parameters Active: Specifies the active level. 

Remark This processing is executed immediately after the program starts for the assigned 

number of digital input panels. 

Processing Updates the digital input status. DGIN_INIT 

Format DGIN_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Performs digital input. DGIN_PROC 

Format DGIN_PROC (Fout, Port, Active, Value, Trig) 

Parameters Fout: Specifies the variable for storing the digital input value. 

Port: Number of the port to which digital data is input 

Active: Specifies the active level. 

Value: Chattering elimination time (ms units) 

Trig: Specifies the variable to which the trigger for counting the chattering 

elimination time is specified (fixed to fTrg 10 ms). 

Remark The port number is handled as the number that remains when “P” is omitted from the 

port name. 

Examples: P01 → 1 

 P140 → 140 

Processing Initializes key and switch input. KEY_INIT0 

Format KEY_INIT0 

Parameters None 

Remark This initialization is required for performing chattering processing for keys and 

switches. 

 

 

A.2.2 Digital output 

 

Processing Outputs digital data. DGOUT_PROC 

Format DGOUT_PROC (Out, In, Active) 

Parameters Out: Specifies the number of the port from which digital data is output. 

In: Specifies the digital output value. 

Active: Specifies the active level. 

Remark The port number is handled as the number that remains when “P” is omitted from the 

port name. 

Examples: P01 → 1 

 P140 → 140 
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A.2.3 Analog input 

 

Processing Inputs analog data. ANI_PROC 

Format ANI_PROC (Ch, Mode) 

Parameters Ch: Specifies the port to which analog data is input. 

Mode: Specifies the mode for processing analog input panels. 

 TYPE_COMPARE_VAL_AD: Compare mode 

 TYPE_COMPARE_RANGE_AD: Range specification mode 

 TYPE_BIT_AD: Bit mode 

− Remark 

Processing Extracts the result of analog input. ANI_OUT 

Format ANI_OUT (ValH, ValL, Out) 

Parameters ValH: Specifies the upper limit of comparison. 

 Specifies the bit position in bit mode. 

ValL:  Specifies the lower limit of comparison. 

Out:  Specifies the variable for storing the result (1 or 0). 

− Remark 

 

 

A.2.4 UART6 input 

 

Processing Initializes UART6 input. URX6_INIT0 

Format URX6_INIT0 (B_rate, D_bit, Parity, F_bit) 

Parameters B_rate: Specifies 1/100 the transfer rate (bps). 

 (Example: Specifies 96 for 9,600 bps.) 

D_bit: Specifies the number of data bits. 

Parity: Specifies the parity control method. 

F_bit: Specifies the stop bit. 

Remark This processing is executed only once immediately after the program starts. 

Processing Inputs data from UART6. URX6_PROC 

Format URX6_PROC (Mode) 

Parameters Mode: Specifies the panel processing mode. 

 TYPE_COMPARE_VAL: Compare mode 

 TYPE_BIT: Bit mode 

− Remark 

Processing Extracts the data input from UART6. URX6_OUT 

Format URX6_OUT (Val, Out) 

Parameters Val: Specifies the value to be compared in compare mode. 

 Specifies the bit position at which to extract the data in bit mode. 

Out: Specifies the variable for storing the result (1 or 0). 

− Remark 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

A.2.5 UART6 output 

 

Processing Initializes UART6 output. UTX6_INIT0 

Format UTX6_INIT0 (B_rate, D_bit, Parity, S_bit, F_bit) 

Parameters B_rate: Specifies 1/100 the transfer rate (bps). 

 (Example: Specifies 96 for 9,600 bps.) 

D_bit: Specifies the number of data bits. 

Parity: Specifies the parity control method. 

F_bit: Specifies the stop bit. 

− Remark 

Processing Outputs data to UART6. UTX6_PROC 

Format UTX6_PROC (Enable, Bit7, Bit6, Bit5, Bit4, Bit3, Bit2, Bit1, Bit0) 

Parameters Enable: Enables (1) or disables (0) output. 

Bits 7 to 0: Specifies the output value for each bit. 

− Remark 

 

 

A.2.6 UART0 input 

 

Processing Initializes UART0 input. URX0_INIT0 

Format URX0_INIT0 (B_rate, D_bit, Parity, F_bit) 

Parameters B_rate: Specifies 1/100 the transfer rate (bps). 

 (Example: Specifies 144 for 14,400 bps.) 

D_bit: Specifies the number of data bits. 

Parity: Specifies the parity control method. 

F_bit: Specifies the stop bit. 

Remark This processing is executed only once immediately after the program starts. 

Processing Inputs data from UART0. URX0_PROC 

Format URX0_PROC (Mode) 

Parameters Mode: Specifies the panel processing mode. 

 TYPE_COMPARE_VAL: Compare mode 

 TYPE_BIT: Bit mode 

− Remark 

Processing Extracts the data input from UART0. URX0_OUT 

Format URX0_OUT (Val, Out) 

Parameters Val: Specifies the value to be compared in compare mode. 

 Specifies the bit position at which to extract the data in bit mode. 

Out: Specifies the variable for storing the result (1 or 0). 

− Remark 
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A.2.7 UART0 output 

 

Processing Initializes UART0 output. UTX0_INIT0 

Format UTX0_INIT0 (B_rate, D_bit, Parity, S_bit, F_bit) 

Parameters B_rate: Specifies 1/100 the transfer rate (bps). 

 (Example: Specifies 144 for 14,400 bps.) 

D_bit: Specifies the number of data bits. 

Parity: Specifies the parity control method. 

F_bit: Specifies the stop bit. 

− Remark 

Processing Outputs data to UART0. UTX0_PROC 

Format UTX0_PROC (Enable, Bit7, Bit6, Bit5, Bit4, Bit3, Bit2, Bit1, Bit0) 

Parameters Enable: Enables (1) or disables (0) output. 

Bits 7 to 0: Specifies the output value for each bit. 

− Remark 

 

 

A.2.8 Simple PWM output 

 

Processing Initializes simple PWM output. PULSE_INIT0 

Format PULSE_INIT0 (DutyMode, OutPort) 

Parameters DutyMode: Number of output stages (3 or 5) 

OutPort: Output port number 

Remark The port number is handled as the number that remains when “P” is omitted from the 

port name.  It is called immediately after the program starts for the number of 

assigned panels. 

Processing Updates simple PWM output processing. PULSE_INIT 

Format PULSE_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Performs simple PWM output. PULSE_PROC 

Format PULSE_PROC (In1, In2, In3, In4, In5) 

Parameters In1: Value input to the 100% input pin 

In2: Value input to the 75% input pin if the number of output stages is 5 

 Value input to the 50% input pin if the number of output stages is 3 

In3: Value input to the 50% input pin if the number of output stages is 5 

 Value input to the 0% input pin if the number of output stages is 3 

In4: Value input to the 25% input pin if the number of output stages is 5 

 Fixed to 0 if the number of output stages is 3 

In5: Value input to the 0% input pin if the number of output stages is 5 

 Fixed to 0 if the number of output stages is 3 

− Remark 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

A.2.9 PWM output 

 

Processing Initializes PWM output. PWM_INIT0 

Format PWM_INIT0 (OutPort, Freq) 

Parameters OutPort: Specifies the port that performs PWM output. 

Freq: Specifies the PWM output frequency. 

Remark This processing is executed only once immediately after the program starts. 

Processing Updates PWM output processing. PWM_INIT 

Format PWM_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Specifies the PWM output parameters. PWM_PARAM 

Format PWM_PARAM (Duty, In) 

Parameters Duty: Specifies the duty factor. 

In: Enables (1) or disables (0) output. 

− Remark 

Processing Performs PWM output. PWM_PROC 

Format PWM_PROC 

Parameters None 

− Remark 

 

 

A.2.10 Stepping-motor output 

 

Processing Initializes stepping-motor output. SMOT_INIT0 

Format SMOT_INIT0 (OutA, OutB, OutC, OutD, Excit, Speed) 

Parameters OutA, OutB, OutC, OutD: Output ports 

Excit: Excitation method 

Speed: Specifies the rotation speed. 

− Remark 

Processing Starts processing stepping-motor output. SMOT_INIT 

Format SMOT_INIT 

Parameters None 

− Remark 

Processing Outputs a signal to the stepping motor. SMOT_PROC 

Format SMOT_PROC (Enb, Dir) 

Parameters Enb: Enables (1) or disables (0) operation. 

Dir: Specifies the rotation direction. 

− Remark 
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APPENDIX  A   AUTOMATICALLY  GENERATED  FILES  (FOR  78K0/Kx2  AND  78K0R/KE3-L) 

A.2.11 Web input 

 

Processing No processing WEBI_PROC 

Format WEBI_PROC 

Parameters None 

− Remark 

Processing Performs Web input. WEBI_OUT 

Format WEBI_OUT (In, Out) 

Parameters In: Web input number 

Out: Specifies the variable for storing the input result. 

− Remark 

 

 

A.2.12 Buzzer 

 

Processing Initializes output to the buzzer. BUZZ_INIT0 

Format BUZZ_INIT0 (OutPort) 

Parameters OutPort: Specifies the output port. 

− Remark 

Processing Updates the status of the output to the buzzer. BUZZ_INIT 

Format BUZZ_INIT 

Parameters None 

− Remark 

Processing Outputs data to the buzzer. BUZZ_PROC 

Format BUZZ_PROC (In2000, In1000, In500) 

Parameters In2000: Enables (1) or disables (0) 2,000 Hz output. 

In1000: Enables (1) or disables (0) 1,000 Hz output. 

In500: Enables (1) or disables (0) 500 Hz output. 

− Remark 
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A.2.13 LCD output 

 

Processing Initializes output to the LCD. LCD2_INIT0 

Format LCD2_INIT0 

Parameters None 

− Remark 

Processing Outputs data to the LCD. LCD2_PROC 

Format LCD2_PROC (Line, Position, Type, CharNum, String, Enble, in_7, in_6, in_5, in_4, 

in_3, in_2, in_1, in_0) 

Parameters Line: Output row position 

Position: Output digit position 

Type: Output mode 

CharNum: Number of digits output 

String: Character string output 

Enable: Enabling (1) or disabling (0) of output 

In_x: Specifies the output value by using a bit. 

− Remark 

 

 

A.2.14 7-segment LED output 

 

Processing Initializes output to the 7-segment LED. SEG_INIT0 

Format SEG_INIT0 

Parameters None 

− Remark 

Processing Displays data for the 7-segment LED. SEG_DISP 

Format SEG_DISP 

Parameters None 

Remark Specify the value to display by using a 7-segment display panel. 

Processing Displays data for the 7-segment LED. SEG_DISP_1 

Format SEG_DISP_1 (ucSeg) 

Parameters ucSeg: Data to be output 

Remark Used in SEG_DISP. 
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A.2.15 Logic 

 

Processing Performs AND processing for the input values. AND_PROC 

Format AND_PROC (In1, In2, Out) 

Parameters Stores the logical product of In1 and In2 into Out. 

− Remark 

Processing Performs OR processing for the input values. OR_PROC 

Format ucflg = ORF (In1, In2) 

Parameters Stores the logical sum of In1 and In2 into Out. 

− Remark 

Processing Performs XOR processing for the input values. XOR_PROC 

Format XOR_PROC (In1, In2, Out) 

Parameters Stores the exclusive logical sum of In1 and In2 into Out. 

− Remark 

Processing Performs NOT processing for the input value. NOT_PROC 

Format NOT_PROC (In, Out) 

Parameters Stores the result of In negation into Out. 

− Remark 

 

 

A.2.16 Comparator 

 

Processing Initializes comparator processing. COMP_INIT0 

Format COMP_INIT0 

Parameters None 

− Remark 

Processing Specifies the value to compare by using the comparator. COMP_PARAM 

Format COMP_PARAM (In7, In6, In5, In4, In3, In2, In1, In0) 

Parameters Specifies the value to compare for each bit. 

Remark To compare two values, specify two COMP_PARAM rows. 

Processing Compares the values. COMP_PROC 

Format COMP_PROC (OutBig, OutEqual, OutSmall) 

OutBig: Outputs 1 if A > B. 

OutEqual: Outputs 1 if A = B. 

OutSmall: Outputs 1 if A < B. 

Parameters 

− Remark 
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A.2.17 Flip-flops 

 

Processing Initializes JK-flip-flops. JKFF_INIT0 

Format JKFF_INIT0 (init) 

Parameters init: Specifies the initial output value from the Q pin. 

Remark This processing is executed immediately after the program starts for the number of 

assigned JK-flip-flop panels. 

Processing Updates the statuses of JK-flip-flops. JKFF_INIT 

Format JKFF_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Processes JK-flip-flops. JKFF_PROC 

Format JKFF_PROC (Jin, Clk, Kin, Qout, Qout2) 

Parameters Jin: J input pin 

Clk: CK input pin 

Kin: K input pin 

Qout: Q output pin 

Qout2: Q output pin 

− Remark 

Processing Initializes RS-flip-flops. RSFF2_INIT0 

Format RSFF2_INIT0 (init) 

Parameters init: Specifies the initial output value from the Q pin. 

Remark This processing is executed immediately after the program starts for the number of 

assigned RS-flip-flop panels. 

Processing Updates the statuses of RS-flip-flops. RSFF2_INIT 

Format RSFF2_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Processes RS-flip-flops. RSFF2_PROC 

Format RSFF2_PROC (Sin, Rin, Out, Out2) 

Parameters Sin: Set input pin 

Rin:  Reset input pin 

Out:  Q output pin 

Out2: Q output pin 

Remark This processing is used for RS-flip-flop panels that have two output pins. 

Processing Initializes T-flip-flops. TFF2_INIT0 

Format TFF2_INIT0 (init) 

Parameters init: Specifies the initial output value from the Q pin. 

Remark This processing is executed immediately after the program starts for the number of 

assigned T-flip-flop panels. 

Processing Updates the statuses of T-flip-flops. TFF2_INIT 

Format TFF2_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 
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Processing Processes T-flip-flops. TFF2_PROC 

Format TFF2_PROC (Reset, Tin, Out, Out2) 

Parameters Reset: Reset input pin 

Tin:  T input pin 

Out:  Q output pin 

Out2:  Q output pin 

Remark This processing is used for T-flip-flop panels that have two output pins. 

Processing Initializes D-flip-flops. DFF2_INIT0 

Format DFF2_INIT0 (init) 

Parameters init: Specifies the initial output value from the Q pin. 

Remark This processing is executed immediately after the program starts for the number of 

assigned D-flip-flop panels. 

Processing Updates the statuses of D-flip-flops. DFF2_INIT 

Format DFF2_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Processes D-flip-flops. DFF2_PROC 

Format DFF2_PROC (Din, Clk, Out, Out2) 

Parameters Din: Data input pin 

Clk: Clock input pin 

Out: Q output pin 

Out2: Q output pin 

Remark This processing is used for D-flip-flop panels that have two output pins. 

 

 

A.2.18 Counter 

 

Processing Initializes the counter. CNT_INIT0 

Format CNT_INIT0 

Parameters None 

− Remark 

Processing Updates the counter. CNT_INIT 

Format CNT_INIT 

Parameters None 

− Remark 

Processing Counts by using the counter. CNT_PROC 

Format CNT_PROC (In, Reset, Type, Limit) 

Parameters In:  Count clock 

Reset: Counter reset 

Type: Counter operating mode 

Limit: Maximum counter value 

− Remark 
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Processing Outputs data to the counter. CNT_OUT 

Format CNT_OUT (Val, Out) 

Parameters Stores 1 into Out if the count value reaches Val or stores 0 otherwise. 

− Remark 

Processing Initializes the binary counter. BCNT_INIT0 

Format BCNT_INIT0 

Parameters None 

Remark This processing is executed only once immediately after the program starts, 

regardless of the number of assigned binary counter panels. 

Processing Updates the status of the binary counter. BCNT_INIT 

Format BCNT_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Counts by using the binary counter. BCNT_PROC 

Format BCNT_PROC (max, mr, cp0, cp1, O0, O1, O2, O3) 

Parameters max: Specifies the maximum value to which to count (BCD: 9, HEX15). 

mr: MR input pin 

cp0: C0 input pin 

cp1: C1 input pin 

O0: O0 output pin 

O1: O1 output pin 

O2: O2 output pin 

O3: O3 output pin 

Remark Expresses the count value by using the four bits O0 to O3, with O0 as the LSB. 

 

 

A.2.19 Timer 

 

Processing Initializes the timer. TIMER_INIT0 

Format TIMER_INIT0 

Parameters None 

− Remark 

Processing Initializes the timer. TIMER_INIT 

Format TIMER_INIT 

Parameters None 

− Remark 

Processing Processes the timer. TIMER_PROC 

Format TIMER_PROC (Mode, Sec, MiliSec, In, Out) 

Parameters Mode: Timer operating mode 

Sec: Operating time (s) 

MiliSec: Operating time (ms) 

In: Panel input 

Out: Panel output 

− Remark 
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A.2.20 Delay 

 

Processing Initializes the delay. DELAY_INIT0 

Format DELAY_INIT0 

Parameters None 

− Remark 

Processing Initializes the delay. DELAY_INIT 

Format DELAY_INIT 

Parameters None 

− Remark 

Processing Processes the delay. DELAY_PROC 

Format DELAY_PROC (Sec, MiliSec, In, Out) 

Parameters Sec: Operating time (s) 

MiliSec: Operating time (ms) 

In: Panel input 

Out: Panel output 

− Remark 

 

 

A.2.21 Clock 

 

Processing Initializes clock panels. CLK_INIT0 

Format CLK_INIT0 

Parameters None 

Remark This processing is executed only once immediately after the program starts, 

regardless of the number of assigned clock panels. 

Processing Updates the statuses of clock panels. CLK_INIT 

Format CLK_INIT 

Parameters None 

Remark This processing is executed every time the main loop cycle starts. 

Processing Generates a clock. CLK_PROC 

Format CLK_PROC (Sec, MiliSec, Trig, Out) 

Parameters Sec: Clock cycle (s) 

MiliSec: Clock cycle (ms) 

Trig: Specifies the variable for which the trigger for measuring the clock cycle is 

specified. 

Out: Panel output 

− Remark 
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A.2.22 Logic IC 

 

Processing 2-input NAND 

74HC00-compliant processing 

IC74HC00_PROC 

Format IC74HC00_PROC (A_in, B_in, Y_out) 

Parameters Outputs the negative logical product of two input signals (A_in and B_in) to Y_out. 

− Remark 

Processing 2-input NOR 

74HC02-compliant processing 

IC74HC02_PROC 

Format IC74HC02_PROC (A_in, B_in, Y_out) 

Parameters Outputs the negative logical sum of two input signals (A_in and B_in) to Y_out. 

− Remark 

Processing 3-input NAND 

74HC10-compliant processing 

IC74HC10_PROC 

Format IC74HC10_PROC (A_in, B_in, C_in, Y_out) 

Parameters Outputs the negative logical product of three input signals (A_in, B_in, and C_in) to 

Y_out. 

− Remark 

Processing 3-input AND 

74HC11-compliant processing 

IC74HC11_PROC 

Format IC74HC11_PROC (A_in, B_in, C_in, Y_out) 

Parameters Outputs the logical product of three input signals (A_in, B_in, and C_in) to Y_out. 

− Remark 

Processing 4-input NAND 

74HC20-compliant processing 

IC74HC20_PROC 

Format IC74HC20_PROC (A_in, B_in, C_in, D_in, Y_out) 

Parameters Outputs the negative logical product of four input signals (A_in, B_in, C_in, and 

D_in) to Y_out. 

− Remark 

Processing 4-input AND 

74HC21-compliant processing 

IC74HC21_PROC 

Format IC74HC21_PROC (A_in, B_in, C_in, D_in, Y_out) 

Parameters Outputs the logical product of four input signals (A_in, B_in, C_in, and D_in) to 

Y_out. 

− Remark 

Processing 3-input NOR 

74HC27-compliant processing 

IC74HC27_PROC 

Format IC74HC27_PROC (A_in, B_in, C_in, Y_out) 

Parameters Outputs the negative logical sum of three input signals (A_in, B_in, and C_in) to 

Y_out. 

− Remark 
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Processing 8-input NAND 

74H30-compliant processing 

IC74HC30_PROC 

Format IC74HC30_PROC (A_in, B_in, C_in, D_in, E_in, F_in, G_in, H_in, Y_out) 

Parameters Outputs the negative logical product of eight input signals (A_in to H_in) to Y_out. 

− Remark 

Processing 2/3-input AND-OR-NOT 

74HC51-compliant processing 

IC74HC51_PROC 

Format IC74HC51_PROC (A1_in, B1_in, C1_in, D1_in, E1_in, F1_in, A2_in, B2_in, C2_in, 

D2_in, Y1_out, Y2_out) 

Parameters Outputs the negative logical product of the logical sums of both 1A to 1C and 1D to 

1F as 1Y, and outputs the negative logical product of the logical sums of both 2A and 

2B and 2C and 2D as 2Y. 

− Remark 

Processing 4-bit bistable latch 

Initializes 74HC77-compliant processing. 

IC74HC77_INIT0 

Format IC74HC77_INIT0 

Parameters None 

− Remark 

Processing 4-bit bistable latch 

Initializes 74HC77-compliant processing. 

IC74HC77_INIT 

Format IC74HC77_INIT 

Parameters None 

− Remark 

Processing 4-bit bistable latch 

74HC77-compliant processing 

IC74HC77_PROC 

Format IC74HC77_PROC (D_in, G_in, Q_out) 

Parameters Supports 74HC77 pins.  Individual description is omitted. 

− Remark 

Processing J-K FF with clear, preset and clock 

Initializes 74HC112-compliant processing. 

IC74HC112_INIT0 

Format IC74HC112_INIT0 

Parameters None 

− Remark 

Processing J-K FF with clear, preset and clock 

Initializes 74HC112-compliant processing. 

IC74HC112_INIT 

Format IC74HC112_INIT 

Parameters None 

− Remark 

Processing J-K FF with clear, preset and clock 

74HC112-compliant processing 

IC74HC112_PROC 

Format IC74HC112_PROC (CLR_in, PR_in, J_in, K_in, CK_in, Q_out, invQ_out) 

Parameters Supports 74HC112 pins.  Individual description is omitted. 

− Remark 
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Processing 13-input NAND 

74HC133-compliant processing 

IC74HC133_PROC 

Format IC74HC133_PROC (A_in, B_in, C_in, D_in, E_in, F_in, G_in, H_in, I_in, J_in, K_in, 

L_in, M_in, Y_out) 

Parameters Outputs the negative logical product of 13 input signals (A_in to M_in) to Y_out. 

− Remark 

Processing 3 to 8 line decoder 

74HC138-compliant processing 

IC74HC138_PROC 

Format IC74HC138_PROC (G1_in, G2A_in, G2B_in, A_in, B_in, C_in, Y0_out, Y1_out, 

Y2_out, Y3_out, Y4_out, Y5_out, Y6_out, Y7_out) 

Parameters Supports 74HC138 pins.  Individual description is omitted. 

− Remark 

Processing 8 to 3 priority line encoder 

74HC148-compliant processing 

IC74HC148_PROC 

Format IC74HC148_PROC (E0_in, In0_in, In1_in, In2_in, In3_in, In4_in, In5_in, In6_in, 

In7_in, A0_out, A1_out, A2_out, GS_out, EO_out) 

Parameters Supports 74HC148 pins.  Individual description is omitted. 

− Remark 

Processing 4-channel multiplexer 

74HC153-compliant processing 

IC74HC153_PROC 

Format IC74HC153_PROC (G_in, A_in, B_in, C0_in, C1_in, C2_in, C3_in, Y_out) 

Parameters Supports 74HC153 pins.  Individual description is omitted. 

− Remark 

Processing Initializes 74HC166-compliant processing. IC74HC166_INIT0 

Format IC74HC166_INIT0 

Parameters None 

− Remark 

Processing Initializes 74HC166-compliant processing. IC74HC166_INIT 

Format IC74HC166_INIT 

Parameters None 

− Remark 

Processing 8-bit parallel-in or serial-out shift register 

74HC166-compliant processing 

IC74HC166_PROC 

Format IC74HC166_PROC (CLR_in, SL_in, CK_INH_in, CK_in, S_IN_in, A_in, B_in, C_in, 

D_in, E_in, F_in, G_in, H_in, QH_out) 

Parameters Supports 74HC166 pins.  Individual description is omitted. 

− Remark 

Processing 9-bit parity generator 

74HC280-compliant processing 

IC74HC280_PROC 

Format IC74HC280_PROC (A_in, B_in, C_in, D_in, E_in, F_in, G_in, H_in, I_in, EVEN_out, 

ODD_out) 

Parameters Supports 74HC280 pins.  Individual description is omitted. 

− Remark 
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Processing 4-bit binary full adder 

74HC283-compliant processing 

IC74HC283_PROC 

Format IC74HC283_PROC (A1_in, A2_in, A3_in, A4_in, B1_in, B2_in, B3_in, B4_in, C0_in, 

Q1_out, Q2_out, Q3_out, Q4_out, C4_out) 

Parameters Supports 74HC283 pins.  Individual description is omitted. 

− Remark 

Processing 4-input NOR 

74HC4002-compliant processing 

IC74HC4002_PROC 

Format IC74HC4002_PROC (A_in, B_in, C_in, D_in, Y_out) 

Parameters Supports 74HC4002 pins.  Individual description is omitted. 

− Remark 

Processing 4-input OR 

74HC4072-compliant processing 

IC74HC4072_PROC 

Format IC74HC4072_PROC (A_in, B_in, C_in, D_in, Y_out) 

Parameters Outputs the logical sum of four input signals (A_in, B_in, C_in, and D_in) to Y_out. 

− Remark 

Processing 3-input OR 

74HC4075-compliant processing 

IC74HC4075_PROC 

Format IC74HC4075_PROC (A_in, B_in, C_in, Y_out) 

Parameters Outputs the logical sum of three input signals (A_in, B_in, and C_in) to Y_out. 

− Remark 

Processing 8-input OR and NOR 

74HC4078-compliant processing 

IC74HC4078_PROC 

Format IC74HC4078_PROC (A_in, B_in, C_in, D_in, E_in, F_in, G_in, H_in, X_out, Y_out) 

Parameters Outputs the logical sum and negative logical sum of eight input signals (A_in to 

H_in) to X_out and Y_out, respectively. 

− Remark 

Processing BCD to 7-segment latch 

Initializes 74HC4511-compliant processing. 

IC74HC4511_INIT0 

Format IC74HC4511_INIT0 

Parameters None 

− Remark 

Processing Initializes 74HC4511-compliant processing. IC74HC4511_INIT 

Format IC74HC4511_INIT 

Parameters None 

− Remark 

Processing 74HC4511-compliant processing IC74HC4511_PROC 

Format IC74HC4511_PROC (LE_in, BI_in, LT_in, A_in, B_in, C_in, D_in, a_out, b_out, 

c_out, d_out, e_out, f_out, g_out) 

Parameters Supports 74HC280 pins.  Individual description is omitted. 

− Remark 
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Processing 2-input XNOR 

74HC7266-compliant processing 

IC74HC7266_PROC 

Format IC74HC7266_PROC (A_in, B_in, Y_out) 

Parameters Supports 74HC7266 pins.  Individual description is omitted. 

− Remark 
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APPENDIX B  AUTOMATICALLY GENERATED FILES (FOR 78K0S/Kx1+) 
 

 

B.1 File Structure 
 

Applilet EZ PL generates assembly source and include files for the 78K0S Series based on the information about 

the assigned panels and automatically generates object code (*.hex) that can be executed in the 78K0S/Kx1+ by 

using an assembler. 

The assembly source file is generated by Applilet EZ PL and stored in the folder specified by selecting the 

[Settings] menu and then a project file in the Saved Data Folder dialog box. 

 

Figure B-1.  Files Generated by Applilet EZ PL (for 78K0S/Kx1+) 

 

Panel location file 

[Generated files]

 (Files that have fixed contents) 

MAC.INC 
 
… 
… 
… 

BASE.ASM 
 
… 
… 
… 

CONF.INC 
 
… 
… 
… 

PANEL.INC 
 
… 
… 
… 

xxx.loc 
 
INPUT 
… 
PROCESS 
… 

 
 

• CONF.INC: File that includes the parameters and definitions for specifying the microcontroller operation 

• MAC.INC: Assembly language macro file 

• PANEL.INC: Assembly source file generated from panel information 

• BASE.ASM: Assembly language file used as the basis for generating an object file 

 

[Caution] The files above are overwritten if object code (*.hex) is generated by Applilet EZ PL.  Therefore, 

when referencing the generated source file, use only the file after copying the folder containing 

the file to a different location. 

 Note that NEC Electronics makes no guarantees about the contents of the files generated by 

Applilet EZ PL. 
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APPENDIX C  EXAMPLE OF THE 7-SEGMENT LED CONNECTION CIRCUIT IN THE 
78K0/KE2 AND 78K0/KF2 

 

 

To install a 7-segment LED in the 78K0/KE2 or 78K0/KF2, connect the 7-segment LED according to the following 

circuit example. 

 

Figure C-1.  Example of a 7-Segment LED Connection Circuit 

 

 

 

 

 

User’s Manual  U17656EJ6V0UM 162 



 

APPENDIX  D   INDEX 
 

[[] Repeatedly assigning panels …  63 

Rotating panels …  65 [Common] tab …  42, 49 

Selecting multiple panels …  63 [Other I/Os] tab …  42, 53 

Shifting panels horizontally …  65 [TK-78K0/KC2L I/Os] … 46, 53  

Shifting panels vertically …  65 [TK-78K0R/KE3L I/Os] …  46, 53 

Specifying properties …  65 

[7] Undoing …  66 

Error messages …  135 7-segment LED jumper entrance …  58 

Estimated amount of used ROM …  75 7-segment LED jumper exit …  53, 54 

evaluation board …  16 

[A] External clock …  123 

A/D converter …  43, 49 

[F] AND operation …  55 

Flash Memory Programmer Settings dialog box …  

131 

assembler …  16 

Automatically generating object code …  35, 67 

Flash writing …  35 

[B] folder structure …  20 

BASE.ASM …  161 

[G] Build area …  41 

Generating …  35, 67 

[C] 
[H] C compiler …  16 

Help area …  41 CC78K0 …  16 
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Install the USB driver …  23 CONF.INC …  161 
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[M] [D] 
MAC.INC …  161 duty factor …  93 

Main window … 39 

[E] Automatically generating object code …  67 

Editing area …  40 Editing area …  40 

Editing panels …  63 Editing panels …  63 

Menu bar …  70 Assigning panels from the pallet …  63 

Panel functions…  42 Changing the panel size …  65 

Right-click menu …  69 Clearing all panels …  66 

Saving and reading data …  67 Copying, cutting, and pasting panels …  63 

Status bar …  75 Deleting panels …  64 

Toolbar …  74 Displaying information about the corresponding 

jumpers …  66 Writing to flash memory …  67 

Menu bar …  70 Moving panels …  64 
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[N] Timer …  60 

UART0 input …  44 NOT operation …  56 

UART0 jumper output …  57 

[O] UART0 output …  51 

UART1 input …  45 Object code (*.hex) …  35, 67 

UART1 output …  51 Operating Environment …  15 

UART6 input …  44 Operation Procedure …  31 

UART6 jumper output …  57 Automatically generating object code …  35 

UART6 output …  51 Editing panels …  32 

Wiring …  55 Selecting the target CPU …  31 

Port Setting dialog box …  120 Simulation …  33 

Processing block area …  40 Writing to the 78K0/Kx2, 78K0S/Kx1+, 78K0R/KE3-

L, or 78K0/KC2-L …  35 Processing panels …  54 

Program development overview …  14 OR operation …  56 

programming elements …  30 Output block area …  40 

project file (*.prj) …  141 Output panels …  49 

Property Settings dialog box …  76 

[P] 7-segment display …  102 

7-segment LED jumper (bit type) …  110 Pallet …  39 

7-segment LED jumper (digit type) …  108 Panel functions …  42 

7-segment LED jumper (segment type) …  109 panel location file (*.loc) …  35, 67, 70 

Analog input …  82 PANEL.INC …  161 

Analog input (illuminance) …  90 Panels 

Binary counter …  113 7-segment display …  53, 54 

Buzzer …  101 7-segment LED jumper …  58 

Clock …  116 Analog input …  43 

Comparator …  105 Analog input (illuminance) …  49 

Counter …  112 Binary counter …  59 

Delay …  115 Buzzer …  54 

Digital input …  81 Clock …  60 

Digital output …  91 Comparator …  56 

DIP switch …  89 Counter …  59 

Flip-flop …  111 Delay …  60 

Jumper …  104 Digital input …  43 

LVI …  87 Digital output …  50 

Musical-scale output …  100 DIP switch …  47, 48 

Push button …  88 Flip-flop …  59 

PWM output …  93 Jumper …  55 

Reset …  119 Logic …  55, 56 

Simple PWM …  92 LVI …  45 

Step motor …  97 Musical-scale output …  52 

Stepping motor …  117 NC …  55 

Timer …  114 Push button …  46 

UART0 input …  85 PWM output …  50 

UART0 jumper output …  107 Reset …  61 

UART0 output …  95 Simple PWM …  50 

UART1 input …  86 Step motor …  52 

UART1 output …  96 Stepping motor …  61 
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[U] UART6 input …  84 

UART transmission jumper entrance …  57 UART6 jumper output …  106 

UART0 Settings dialog box …  125 UART6 output …  94 

UART1 Settings dialog box …  127 

[R] UART6 Settings dialog box …  129 

Uninstall …  21 RA78K0 …  16 

RA78K0R …  16 

[W] RA78K0S …  16 

Watchdog Timer Setting dialog box …  124 Reading …  67 

Window reference …  37 Right-click menu …  69 

Flash Memory Programmer Settings dialog box …  

131 

Rotate …  54 

[S] Main window …  39 

Port Setting dialog box …  120 Saved Data Folder dialog box …  133 

Property Settings dialog box …  76 Saving …  67 

Saved Data Folder dialog box …  133 shortcut icon …  21 

Target CPU Settings dialog box …  122 Simulation …  13 

UART0 Settings dialog box …  125 Simulation area …  41 

UART1 Settings dialog box …  127 Starting Applilet EZ PL …  29 

UART6 Settings dialog box …  129 Stepping motor …  117 

Watchdog Timer Setting dialog box …  124 System Components …  15 

Windows [Start] menu …  21 
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